AVR-8-bit-Mikrocontroller
Gruppe 500 - CodeVisionAVR C-Compiler
Teil 502 - Aufbau eines C-Projektes

AVR

Teil 501 - EinfUhrung

1 Eine Einfuhrung in C
1.1 WarumC ?
1.2 Wie entstand C ?
1.3 Der AVR-Mikrocontroller in einem eingebetteten System
1.4 Werkzeuge (siehe Gruppe 200)

Teil 502 - Aufbau eines C-Projektes

2 Was ist ein C-Projekt ?
2.1 Erzeugen eines C-Projektes
2.1.1 Ein neues Projekt beginnen
2.1.2 Ein C-Projekt generieren
2.2 Dateistruktur eines C-Projektes
2.3 Einbindung von AVR Studio in den CVAVR
2.4 AVR Studio Debugger
2.5 C-Compiler-Optionen

Teil 503 - Preprozessor

3 Preprozessor-Anweisungen
3.1 Struktur der C-Quell-Programme
3.2 #include-Anweisung
3.3 #define-Anweisung (Makro)
3.3.1 Makros ohne Parameter
3.3.2 Makros mit Parametern
3.4 #undef-Anweisung
3.5 #if-, #ifdef-, #ifndef-, #else- und #endif-Anweisungen
3.6 Andere Preprozessor-Anweisungen

Teil 504 - Syntax der C-Programmiersprache

4 Die Syntax der C-Programmiersprache
4.1 C-Quell-Programme
4.1.1 Kommentare
4.1.2 Deklarationen (Vereinbarungen)
4.1.3 Die Funktion main
4.1.4 Schlisselworter (Keywords) des CodeVisionAVR C-Compilers
4.2 Konstanten und Variablen
4.2.1 Zahlensysteme
4.2.2 Datentypen
4.2.3 Konstanten
4.2.4 Variablen
4.3 Operatoren
4.3.1 Arithmetische Operatoren
4.3.2 Relationale Operatoren
4.3.3 Logische und bitweise wirkende Operatoren
4.3.4 Andere Operatoren und Shortcuts
4.4 Komplexe Objekte in C
4.4.1 Funktionen
4.4.2 Funktions-Prototypen
4.4.3 Pointers und Arrays
4.4.3.1 Pointers
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4.4.3.1.1 Pointers in Verbindung mit £1lash und eeprom
4.4.3.1.2 Pointers in Verbindung mit typede£f
4.4.3.2 Arrays
4.4.3.2.1 Ein-dimensionale Arrays
4.4.3.2.2 Zwei-dimensionale Arrays
4.4.3.2.3 Drei-dimensionale Arrays
4.4.3.3 Benutzen der Array-Namen als Pointers
4.4.3.4 Arrays von Pointers
4.4.3.5 Pointers auf Funktionen (Funktionszeiger)
4.4.3.6 Funktionen in Verbindung mit typedef
4.4.4 Strukturen und Unionen
4.4.4.1 Strukturen
4.4.4.2 Unionen
4.4.5 Komplexe Typen (eine Zusammenfassung)
4.5 Steuerung des Programmablaufs
4.5.1 Anweisungsblocke { . . . }
4.5.2 Die Anweisung if
4.5.3 Die Anweisung if in Verbindung mit else
4.5.4 Die Fallunterscheidung switch
4.5.5 Die Schleife for
4.5.6 Die Schleife while
4.5.7 Die Schleife do in Verbindung mit while
4.6 Arbeiten mit den Ein-/Ausgabe-Ports

Teil 505 - Modularer Aufbau der AVR-C-Projekte
5 Modularer Aufbau

5.1 Das Konzept

5.2 Nomenklatur

5.3 Die speziellen Header-Dateien
5.3.1 Die spezielle Header-Datei typede£fs.h (Typ- und Bit-Definitionen)
5.3.2 Die spezielle Header-Datei iomx . h (Definitionen aller Register-Bits)
5.3.3 Die spezielle Header-Datei macros . h (Definitionen von Makros)
5.3.4 Die spezielle Header-Datei switches.h (Definitionen von Schaltern)

5.4 Die AVR-C-Module

5.5 Anwendung der angepassten AVR-C-Module
5.5.1 Das AVR-C-Modul application (Anwendungs-Steuerung)
5.5.2 Das AVR-C-Modul 1cd_2wire (Ausgabe auf LCD-20x4)
5.5.3 Das AVR-C-Modul num_conversion (Typ-Konvertierung nach ASCII)
5.5.4 Das AVR-C-Modul adc_ref_1_1 (ADC mit interner Referenz 1,1 V)
5.5.5 Das AVR-C-Modul rc5_decoder (RC5-IR-Fernsteuerung-Dekoder)
5.5.6 Das AVR-C-Modul rc5_encoder (RC5-IR-Fernsteuerung-Enkoder)
5.5.7 Das AVR-C-Modul usart (USART-Steuerung)
5.5.8 Das AVR-C-Modul twi_master (IR2- bzw. TWI-Steuerung)
5.5.9 Das AVR-C-Modul timer0_pwm (TIMERO-Steuerung)

Teil 506 - Anhang

6 Anhang
6.1 Begriffe und Definitionen
6.2 Bibliothek
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Vorbemerkung

Nichts ist vollkommen - und nichts ist endgultig! So auch nicht dieses Tutorial!l Deshalb bitte immer erst
nach dem neuesten Datum schauen. Vielleicht gibt es wieder etwas Neues oder eine Fehlerbereinigung
oder eine etwas bessere Erklarung. Wer Fehler findet oder Verbesserungen vorzuschlagen hat, bitte
melden (info@alenck.de).

Immer nach dem Motto: Das Bessere ist Feind des Guten und nichts ist so gut, dass es nicht noch
verbessert werden konnte.

Bild-, Beispiel-, Form- und Tabellen-Nummern sind nach folgendem Schema aufgebaut, damit bei Ein-
fugungen/Léschungen nicht alle Nummern wieder geédndert werden missen (hier bunt dargestellt):

Darstellungsart Abschnitt-LfdNummer: Beschreibung allgemeines Schema
e Bild 5.1.4-02: Daten-Adress-Raum Benummerung eines Bildes
e Beispiel 5.1.4-03: EEPROM-Speicherung Benummerung eines Beispiels
e Form 5.1.3-01: Die main-Funktion Benummerung einer Formdarstellung
e Tabelle 5.1.4-01: Schlisselwérter vom CVAVR Benummerung einer Tabelle

Gravierende Anderungen gegeniiber der Vorversion

1.
Vollig neue Strukturierung in Gruppen und Teile, um das Tutorial umfassend ordnen zu kénnen. Die
Abschnitte in den Teilen sind weitgehend erhalten geblieben.

Gruppenbezeichnung Kurzbezeichnung

Gruppe 100: Technologie der AVR-8-Bit-Mikrocontroller  Technologie

Gruppe 200: Einsetzen von AVR-Tools Tools

Gruppe 300: Arbeiten mit AVR-Assembler ASM-Programmierung
3xx_Programm_yyyyy ASM-Programm-Beispiel

Gruppe 400: AVR-ASM-Projekte ASM-Projekte
4xx_Projekt_yyyyy ASM-Projekt-Bezeichnung

Gruppe 500: CodeVisionAVR C-Compiler C-Programmierung
5xx_Programm_yyyyy C-Programm-Beispiel

Gruppe 600: AVR-C-Projekte C-Projekte
6xXx_Projekt_yyyyy C-Projekt-Bezeichnung

xx steht fur die laufende Nummer innerhalb des Teils, in dem das Programm bzw. das Projekt erscheint
und yyyyy steht fur die Programm- bzw. Projekt-Kurz-Bezeichnung.

2.
Notwendige Anderungen auf Grund Neuinstallation von Windows 7.

3.
Windows 7 machte eine Installation von CodeVisionAVR V2.60 als Vollversion notwendig. Daraus
leiten sich auch viele Anderungen im Detail fiir die C-Programmierung (Gruppe 500) ab.

4,
Neu-Installation von AVR Studio Vers. 4.19 unter Windows 7

5.
Zur Demonstration des Tools AVR Studio ist in Gruppe 200 eine Trennung in Teil 205 - Assembler
und AVR Studio und Teil 206 - C-Compiler und AVR Studio vorgenommen worden.

6

ASM- und C-Projekte werden jeweils in eigenen Gruppen gesammelt (Gruppe 400 fir Assembler- und
Gruppe 600 fur C-Projekte).
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Vorbemerkung zu diesem Teil 502

AVR-8-bit-Mikrocontroller
Gruppe 500 - CodeVisionAVR C-Compiler
Teil 502 - Aufbau eines C-Projektes

In diesem Teil 502 wird Uberwiegend der Teil 206 - C-Compiler und AVR Studio eingebettet (d.h.
wiederholt), um die C-Programmierung mit Hilfe des CodeVisionAVR C-Compilers hier méglichst zu-
sammenfassend darzustellen zu kdnnen.

2 Was ist ein C-Projekt ?

Ein C-Projekt ist die Summe aller Dateien, die zur Losung eines Aufgaben-Komplexes (einer Anwen-
dung) mittels C-Programmierung notwendig sind.

Es steht hier zunachst nicht die Lésung des Problems im Vordergrund und auch nicht die Aufgaben-
stellung, sondern es wird - um den grundséatzlichen Aufbau eines C-Projektes darzustellen - von ferti-
gen Quell-Dateien ausgegangen, die bereits fertig erstellt, getestet und erprobt sind. Zur Anschauung
wurde das fertige 601_AVR_C_Projekt_ PB_LED (aus der Gruppe 600) gewahlt. Zur Abkirzung des
Namens wird es hier nur mit AVR_PB_LED bezeichnet.

CodeVisionAVR - D:\AVR_PB_LED\AVR_PB_LED. pr

Fie Edt Seach View Piojeot Tools Settings Windows Help
(|0 i~ et IS | SRR [ e 0 el | S5 P 7 7] @00 - 8, 8] 4] |85 7 o0 4R
[P 1 FTREONSES - 0|8 [@¥vs BED |10
Code Havigator | Code Inform 4 | » o (ol x| M= { B typedefs h 8 [l S
B 5% CodevisonéivR AL ][/ =] ([ ra] Tl =[]+ ]
-3 Project: AVA_PB_LED ||| 4z | |¢+ 15 bE]
253 Nates 43| |7/ Beader-pateien: einfuegen: 16( |47 19 |
mainc a1 |14 17|| |/ Header-Datei-einfuegen: 20| |7/ Abirage, b diese Header-Datei bersits sufger
spplication.c 45| |ginclude: "application. k" 18[ | 21| |sr
Headers 46 19| |#include "application.h' 22 |#ifudef  TYPEDEFS H
{] spplicationh A7 ()44 20| |/r 23| |#define-_ TYPEDEFE_H
meh 22 jj Globale Varisblen: g; . é:
g :ﬁx: 50| [ves n; 23| |/ Globale Varisblen: 26| |
1 51 2afl /7 27| |/ Header-Datei-sinfusgen
] tmits ks sz | 25| |volatile V0% app_reset_sourze: 28| s
(] maciosh o | 26|l 25| #inelude <ordio b
wegsBih 54 |sr 27 30 o <stalib k>
stdaigh 55 |5 void wain(void) 28| |/r 31| |#include <ctype.h>
stdio b w0t 2| s - 32| |#include <delsy.h>
stdib h 57 /7 Setzen: des: System-Takues: (CPU-Glack) , - Ausse 30| /s 33| [#incluae - <string n>
stingh 58 app_init(); 31||B|void app_init(void) 34| |#include <limivs.h>
[#] switchesh 58 32 |5t 35| |#include "iomx8_ h'"
[ vpedsis h &0 /7 Inivialisiersn der Tasten (Pushbuctons) 33 app_reset_seurce = MCUSR; 36| |#include: "macros.h®
[% Other Files (3 £1_INITO); 34 37| |#include "switches.h”
62 S2_INIT(); 35 38
63 S3_INITON s 36 s |
64 37 40| |7/ Definitionen besonderer- Schlussselvosrter
65 S5 Initial 38 ar|| s
66 LED1_DDR | : 39 42| |#define true -1
&7 LEDZ_DDR. |= LEDZ_BTT; 40 43| |#detine TRUE. -1
&8 LEB3_DDR 1= LED3_BIT; a1 44| |#define oF 1
69 a2 HCUSR = 0x00; 5| |#gefine-on 1
70 /7 Alle LED's 3-ual sufleuchten lassen' {"Lamps 43 46| |#detine 3BT -1
L for-(a'=3; n; n--) aa| ||/ a7|||#getine s -1
72 i as|| | £/ Durch Vereinstellung ("starcup.asm”) ist der 45
73 LEDI_FRT- |= LED1_BIT: sl ||/ 48| |#dsfine false 0
74 LEDZ_PRT 1= LEDZ_BIT: 47|\ | #1242 5 USE_vATCHDOG 50| |#4efine FALSE: -0
75 LEDG_PRT- I= LED3_BIT: 45 WDTCER = UDCE- |- UDE; 51| |#define QFF -0
76 43 ||| [enais 5z|| [#define-cts -0
77 aelay_ns(250); 50 53| |#4efine CLEAR: -0
78 sL{ /7 54 |#define clear 0
72 LED1_PRT &= ~LEDL BIT; 52|| | /7 Sstzen des woreingsstallten System-Tsktss nur 55
a0 LEDZ_PRT- &= ~LEDZ_BIT; 53| | [#1£de s USE_CRYSTAL_CLOCK s6|| s
3l LED3 PRT &= ~LEDZ EIT; safl ||/ 57| |7/ Datinitionen: der Bic-Tuunern
82 55|\ | [ (_MEU_CLOCK_FREQUENCY - = 16000000) S|l s
83 delay_us(200); =I[| 58 CLEPR = CLEPCE; =|[| 52| #eszinemaTe - 0xea &
4 ] {15 a7 | | |1 2l
Messagesl
[ Insert

Bild 2-01: Das Projekt AVR_PB_LED (hier: fertig kompiliert)

Im linken Teil des Bildes Bild 2-01: Das Projekt AVR_PB_LED istim Code Navigator eine Aufstellung
der Quell-Dateien zu sehen. Die Quell-Dateien mit dem Programm-Quell-Code (*.c-Dateien), d.h. mit
den Programm-Befehlen (Anweisungen, Funktions-Aufrufe, Algorithmen usw.), sind:

e main.c

e application.c

ist das erste aufgerufene Haupt(main)programm mit dem C-Programm-
Quell-Code, d.h. in der Regel mit vielen Funktionsaufrufen. Im rechten
Teil ist der Kode dieses Hauptprogramms aufgerufen und kann dort edi-

tiert werden.

das ist die C-Quell-Datei mit der Initialisierung der Anwendung, d.h. mit

den Anweisungen, die fur die Einstellung des Taktes, der Interrupt-Vek-
toren usw. bendtigt werden.
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Es folgen die Header-Dateien (*.h-Dateien). Da sind als erstes die selbst generierten Header-Dateien
mit den Beschreibungen der Konstanten, Makros, Datentypen, globalen Variablen und den sog. Funk-

tions-Prototypen zu nennen:

application.h

iomx8.h

macros.h
switches.h

typedefs.h

Header-Datei zur Definition der im Projekt veranderbaren Parameter

Header-Datei zur Definition der Bits des benutzten Mikrocontrollers AT-
mega88

Header-Datei zur Definition anwendungsspezifischer Makros
Header-Datei zur Definition der Tast-Schalter

Header-Datei zur Definition "eigener Datentypen” (Definition aquivalen-
ter Namen zu bestehenden Datentypen)

Und zum guten Schluss noch einige globale Header-Dateien, die ebenfalls in der linken Spalte im Bild
2-01 auftauchen. Das sind Header-Dateien aus dem "Datei-Fundus”, der mit CVAVR ausgeliefert wurde
(hierzu mehr im Teil 503 - Der Preprozessor und Teil 504 - Syntax der C-Programme):

ctype.h

delay.h

limits.h

mega88.h

stdarg.h

stdio.h

stdlib.h

string.h

Header-Datei zur Definition von Funktionen zur Bestimmung von Zei-
chen-Typen (z.B. alphanumerische, alphabetische, dezimale Zeichen
usw.).

Header-Datei zur Definition von Funktionen zur Verzégerung schnell ab-
laufender Vorgange.

Header-Datei zur Definition von Minima und Maxima von Datentypen.

Header-Datei zur Definition von controllerspezifischen Registern, Ports,
Timer usw.

Header-Datei zur Definition von Makros zur Behandlung variabler Argu-
menten-Listen.

Header-Datei zur Definition von Funktionen zur Standard-Eingabe und
Standard-Ausgabe.

Header-Datei zur Definition von Standard-Bibliotheksfunktionen.

Header-Datei zur Definition von Funktionen zur Manipulation von Strings
(Zeichenketten).

Wo findet man sie - oder viel wichtiger: wo findet sie der Compiler CVAVR?? Antwort: CVAVR hat sie
beim Setup selbst in den von ihm eingerichteten Ordner

c:\cvavr2\inc

abgelegt und da der Aufruf des Namens mit spitzen Klammern geschieht, z.B. <delay.h>, schaut der
Preprozessor als erstes hier nach:
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-|o| x|
ﬂ @I inc durchsuchen \Q‘
| Datei Bearbeten Ansicht Extras ?
Organisieren ~ Offnen ¥  Brennen  Neuer Ordner = v j Q
& System-LW 400 GB (C:) Al name - Grofe | Anderungsdatum | Typ | IL'
a $Recyde.Bin - 64cl.h 6 KB 21.07.2009 14:57 H-Datei
megabacl. L : -Datel
| 989f7ffafd7fb783c ¢
Benutzer megab4cl_bits.h 53KB 21.07.2009 15:12 H-Datei
)
| cvawr2 mega64m1.h 7KB  21.07.2009 14:50 H-Datei il
| bin megab4m1_bits.h 57 KB 25.05.2010 10:17 H-Datei
| Code Templates mega8s.h . 14.04.2009 15:44
o
k. exampies megagB.hd g 3KB 23.09.201219:49  HCI-Datei
| examples atxmega
inc megassa.h 5KB 14.10.2010 08:54 H-Datei
'
| b ﬂ megassp.h 5KB 14.04.2009 15:45 H-Datei ﬂ
megad8.h Anderungsdatum: 14.04.2009 15:44 Ersteldatum: 07.09.2012 20:15
H-Datei Grofe: 3,95 KB
1 Element ausgewahit | |\ Computer _/

Bild 2-02: Auszug aus dem Datei-Ordner des lokalen Datentragers (C:)

2.1 Erzeugen eines C-Projektes

Zur Demonstration einer Projekt-Generierung wird ein neuer Projekt-Ordner AVR_PB_LED angelegt, in
dem alle fertigen * . c- und * . h-Dateien des fertigen AVR-Projektes AVR_PB_LED (Ubertragen werden.

Siehe: Teil 601 PB_LED - Einfache Beschaltung von LEDs und Tastern

Der Ordner-Name wurde vom Namen des bestehenden Projektes entlehnt. Dieser Ordner und die fol-
genden Schritte dienen gleichermalRen zur Demonstration, wie man als "Neuling" fertig erstellte Projekte
zum Testen benutzen kann. Wenn man ein neues Projekt beginnt, fangt man ja bei "Adam und Eva" an,
d.h. man legt einen neuen Projekt-Ordner an, tbernimmt oder erstellt darin die Quell-Dateien und mar-
schiert dann durch die hier beschriebenen Instanzen.

=lo| x|
‘@\:PL ~ Computer » KINGSTON (L:) ¥ AVR_PB_LED ~ €23 | AvR_PB_LED durchsuchen @‘
| Datei Bearbetten Ansicht Extras 2
Organisieren ¥  Freigeben fir *  Brennen  Neuer Ordner =~ Ol Q
& Sicherungs-L\W 1000 GB (L) Al Name - GroBe Anderungsdatum | Typ | |

& Wechsel-L\W2 160 GB (J:)

4 Nicht angegeben (7
- ExtVideo-LW 1000 GB (K:) geg @

— KINGSTON (L:) application.c 11 KB 15.08.2009 14:17 C compiler source fie
| ALEs_ASM_Progs application.h 36KB 15.08.2009 21:34 H-Datei
| . AVR_PB_LED ‘@ iomx8.h 46 KB  15.08.2009 15:08 H-Datei
~> Wechseldatentrager (M:) macros.h 4KB 15.08.200920:07  H-Datel
& Netzwerk main.c 6 KB 15.09.2012 21:58 C compiler source fie

[Z5 Systemsteuerung

-4 ) switches.h 4KB 15.08.2009 20:09 H-Datei
% Papierkorb
typedefs.h 9KB 15.08.2009 20:13 H-Datei
-
7 Elemente
I
7 Elemente | |;a! Computer ;

Bild 2.1-01: Einen neuen Projekt-Ordner mit Quell-Dateien anlegen
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2.1.1 Ein neues Projekt beginnen

In der Gruppe 200 - Einsetzen von AVR-Tools wurde schon das Tool CodeVisionAVR installiert und
auch schon ein Hinweis gegeben, wie man mit diesem Tool Quell-Dateien editieren kann. Jetzt wird das
erste Projekt (wenn auch nur entlehnt) durch Start dieses Tools erzeugt:

CodcVisionAVR

J Fi Search View Project Tools Settings Help
] EEEEEREEREEEY
n=ge:= —
. EEF AL
J B Cirl+5 QE@E #H | -
}E Save AS... X Code Informa.. % 3 (£ Eﬂg.f Function Call Tree
Bl save &l Shift+Gilss
ﬁ Close Cirl
@ Close Multiple
@ Close Al

Bl convert to Library {* Project

x LCanicel |

Page Setup

PrintPreview

&5 Print G+

¥ Exit Alt+F4
] Messages

[= "R = I

Bild 2.1.1-01: CVAVR fir ein neues Projekt starten

File => New => Create New File => Project => OK

-[ol

File Edit Search View Project Tools Settings Help

|
Do - BEFrEE B ERS.) v |t ma@ < B & EE 7 %% 0-0-8 9|8 BB,
[tat b (MM B I RRONQOEEERE|S  HE. %20 || HAN4a.|[? 6.
S R R R e Er = =
EE: Code Mavigataor V‘?‘El @Eodelnforma...vzsﬂ %F Furction Call Tree $ﬁ—| _%EodeTem... V-?"ﬂ—r%ﬂ\... v = Q|
EI---E\}‘; CodeVisionaYR ‘ if () { =1
----- g Mo Project Ti
o] Other Files
| 8«

t

‘fou are about to create a new project.
| Do you want to use the CodeWizardAVR? do { L
3

Yes No while ()7
while () {

» bi

for (;;) {

=

H Messages W R t‘.i|
B s | E W’amingsl

Bild 2.1.1-02: Anfrage, ob der CodeWizardAVR benutzt werden soll

Es soll der CodeWizardAVR nicht verwendet werden: => No; es meldet sich das Fenster Create New
Project. Dieses verweist zunachst auf den Pfad der CVAVR-Installation

C:\cvavr2\bin

weil der Compiler-Hersteller offenbar davon ausgeht, dass alle Projekte hier konzentriert werden sollen.

Da aber das Projekt in einem eigens dafiir vorgesehenen Ordner angelegt werden soll, missen hier
neue Einstellungen vorgenommen werden.
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Im Feld Speichern in: wird der neu eingerichtete Ordner gesucht.

Hier: AVR_PB_LED => Speichern

Create New Project il Create New Project il
Speichem in: | | bin -l 6 F cE- Speichem in |._, KINGSTON (L) ~ e mEy
Name = Srobe |v| A Name =~ |'| GréBe
. Es wurden keine Suchergebniss€ gefunden. - Nicht angegeben (2)
Zuletzt besucht Zuletzt besucht | ALEs_ASM_Progs
AVR_PB LED
Desktop Desktop
Bibliotheken Bibliotheken
computer Computel
Ne\zwelk Ne\zwerk
< | i < ]
Brimmse | =l Speichem | Dzt | =] Ofinen
Dateityp [Projectiles (~pr) ~| Abbrechen Dateityp: [Projectiies (pr) ~| “Abbrechen

Bild 2.1.1-03: Create New Project
Klick auf = und KINGSTON (L) wahlen

Bild 2.1.1-04: Ordner AVR_PB_LED suchen

AVR_PB_LED markieren => Offnen

Jetzt muss noch der Dateiname fir das Project file (* . pr3j) benannt werden. Sinnvoll ist es, den glei-
chen Namen wie flir den Projekt-Ordner zu wahlen - ndmlich AVR_PB_LED. Nur diese Datei braucht

spater aufgerufen zu werden, um Anderungen im Projekt vorzunehmen. “Sie soll wie folgt abgelegt wer-
den (hier beispielhaft auf dem USB-Stick L:):

L:\AVR_PB_LED\AVR PB_LED.prj

X o «
Speichemin: [ || AVR_PB_LED = e 2 mE Spsichemin: [ || AVR_PB_LED EFa® e
Mame = | -| Grae |- Anderungsdatum |~ Name = | -] Grege |=] Anderungsdatum | -
Es wurden keine Suchergebrisse gefunden. Es wurden keine Suchergebnisse gefunden,
Desktop Desktop
Bibliotheken Bibliotheken
. A
Computer Computer
™
-
Netzwerk
4 | 2l < N | |
»
Dateiname: I J Speichem Dateiname: AVR_PB_LED| ﬂ Speichem
Dateityp: | Project files {"pri) % Abbrechen | Dateityp: | Project files ") | Abbrechen

Bild 2.1.1-05: Es wird eine *.prj-Datei angefordert

Bild 2.1.1-06: Benennen der *.prj-Datei

Es offnet sich zusatzlich das Fenster Configure Project AVR_PB_LED.prj mit der Aufforderung, dem
Projekt nun die Quell-Dateien hinzuzufiigen (besser: bekannt zu machen, da sie sich ja bereits im Pro-
jekt-Ordner befinden).
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4 Configure Project AVR_PB_LED.prj ﬂ

Files | C Compiler | Eefore Build | After Build |
Input Files | Dutput Directaries |

------ @ SR _PE_LEDWAYR_PB_LED.pij o "
Hew |
¥ Add

*

Hemove

[T Edit File Namel
4 Move Up |
¥ ave Dovn |

Add File to Project al x|
Suchenin: [ |, AVR_PB_LED EH ez @
Name =~ | +| GraBe | - Ainderungsdatum |-
Nicht angegeben (6)
Zuletzt besucht: SN 18.03.2012 23:47
D | Linker 18,03.2012 25:47
e | List 18,03.2012 23:47
| ot 18.03.2012 23:47
| application.c 11KB  15.08.2008 15:17
PR [ main.c 6KB  15.08.2009 22:18
-
Computer
h
Netzwerk
« | |
Dateiname: I j Offnen I
v 0K X Cancel | ? Hep | Dateityp [ Compitr fies o} = Abbrechen

Bild 2.1.1-07: Configure Project Add => Bild 2.1.1-08: Neue Projekt-Struktur
Part 1 - Input Files

Im Hauptfenster von CVAVR sieht man bereits, dass auf der linken Seite im Code Navigator der Pro-
jekt-Name AVR_PB_LED und in der Kopfzeile der Name der Projekt-Datei AVR_PB_LED.prj eingetra-
gen sind.

S [=1k3

J_He Edit Search View Project Tools Settings telp |
IDe2-HEd o &S
I

CodeVisionAVR - |_:\AVR_I’B_LED\AVR_PB_L_%Q‘prj
228

BERES. x|t meR B|E&EE s o-e-82|BBwBE|H.
AR B eHE R 1R R0 0BEEERE (D HS. 6% 0. | FaNsa |2,

EE N ECE =R

f&: Code Mavigator @ & 1| B Code Information % % E||%f Function Call Tree % G| |[RYCIEERIINGEEE | = Code Te.. % & || By clip. % 5 &

= E\}‘; CodeVisionAYR if () 4
B Project AvR_PB_LED i

“[J Other Files
& % iE () ¢
}

do |

Bild 2.1.1-09: Hauptfenster von CVAVR

Jetzt missen alle C-Dateien zum Kompilieren und Binden dem Projekt bekannt gemacht werden. Das
Meni lasst automatisch nur C-Dateien zu und weist damit bereits darauf hin, dass nur die C-Dateien
den anfanglichen Start bestimmen. Die Header-Dateien werden erst wahrend der Kompilierung (ge-
nauer: wahrend des Preprozessor-Laufs) aus den C-Dateien heraus aufgerufen und in das Coding ein-
gefigt.

C¥ CVAVR_502.docx 14.03.2020 Seite 9 von 38



AVR-8-bit-Mikrocontroller
Gruppe 500 - CodeVisionAVR C-Compiler
Teil 502 - Aufbau eines C-Projektes

CodeVisionAVR - J:\AVR_PB_LED\AVR_PB_LED.prj

File Edit Search View Project Tools Settings Help

Add File to Project

Suchen in: | || AVR_PE_LED

|
Doo-HEEcEs HER e
|

ER- L=

. el
|v| Anderungsdatum I‘

=[5
8 x| |

Mﬂﬁ@%ﬁvjﬁnin%g°&|ﬁ MName =+ |v|Gr56e
J %| 1 ||F=-|@ %ﬂ%“% Elm| . g Nicht angegeben (6)
E':: Code Navigator %7 5 El @ Code Infarma... & Er Rl | Exe 18.03.2012 23:47 (X |
557, CodeVision&VR D | Linker 18.03.2012 23:47
g Project: &F_PE_LED Desktop | List 18.03.2012 23:47
----- Other Files . Obj 18.03.2012 23:47
E . application.c
Bibliotheken . main.c
Ly
Computer
Ne!zv:érk
4] | i
E3zages $ m
%MErrorsgl E W’amingsl Dateiname: I"main.c" "application.c" j g Offnen I [— 1
| Dateityp: | Compilerfiles (*.c) 4| Abbrachen | |
| |
Bild 2.1.1-10: C-Dateien dem Projekt bekannt machen
Alle C-Dateien auswahlen => Offnen und . . . . OK im Configure Project-Menii
Achtung: Der Vorgang dauert eine Weile - Bitte nicht die Geduld verlieren!
Noch mal der Reihe nach (wegen der Uberschneidung der Meniis):
Bild 2.1.1-06: Benennen der *.prj-Datei: AVR_PB_LED.prj => Speichern
Bild 2.1.1-09: Hauptfenster von CVAVR - zur Ubersicht
Bild 2.1.1-07: Configure Project - Part 1 (das Men bleibt zun&chst noch sichtbar) => Add
Bild 2.1.1-08: Neue Projekt-Struktur
Bild 2.1.1-10: C-Dateien dem Projekt bekannt machen => * . c-Dateien markieren => Offnen
Bild 2.1.1-07: Configure Project => OK
Durch OK im Configure Project werden alle * . c-Dateien in das Projekt ibernommen.

CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LED.prj — IEI Iil
| Fle Edit Search Vew Project Took Settings Help |
D -HEfoEcs B ERE. o~ na@XBH|E|EE /7 |%| -0 -8 8|88 «x &6,
| iR D IXROL[OEEEE QBN 4530, Kakaa.||? 8@,

R R R E R EL ==
= Code Mavigator @ 5 | |B@ Code .. ¥ 5 &% Function Call . 5 O | IECEEIE RGN | = Code Templ.. ¥ 5 d|[Byclip. ¥ %6
E---E\_)‘; CodetisionAVR N o if () 4 =
=13 Project AVR_PB_LED otes i
[ application.c it “} £
[ main.c .
Al Headers do 1 -
-[ ListFiles H
B AvR_PB_LED.asm while ();
B AVR_PB_LEDst while () {

B AVR_PE_LED.map LK

L.[§ OtherFiles — ‘(::J . =
H Messages v Qg

E Errors | E Warningsl
11 | | Insert |

€¥ CVAVR 502.docx

Bild 2.1.1-11: Hauptfenster von CVAVR

14.03.2020
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8)-[ol
JEiIe Edit Search View Project Tools Settings Help
IDe2-BEgdEs 8 ERE. || o B|S|/EE/s 7% o0-0-0 0 B Bx B,
[thts pap MR (B 1RO OEEEE QGBS 2k%20,. HaXsa.[? 0.
|5 %% 1 ey EhEde Ema.
- Code Navigator Code Informa... ¥ 5 E3| | %f Furction Call Tree 5223 [0 ] FE_LED.+ Il x| Ci.. % 5|
5 & _
E-5 CodeVisiondWR © ¢ if O {
[l Project: AYR_PE_LED bi
Mates
[ application.c if ) {
[ main.c 1
- [B Headers |-
¢ =-[H) List Files de |
o [B AVR_PE_LED.asm R
[ &vR_PE_LED kt while (};
[l AWR_PB_LED.map while () {
o[ Other Files b
For (;:) {
N
awitch () {
case :
awitch () {
case
void main(veid) {
1
H Messages W ﬂ—|
E Errars | E W'amingsl
| |

Bild 2.1.1-12: Die Spalten "Function Call Tree", "Code Templates" und "Clipboard History" wer-
den zunachst entfernt, um Platz flr die *.c-Dateien zu erhalten

In der "File Pane" (Editier-Feld, das ist die 4. Spalte von links) - wo bereits die leere * . txt-Datei unter
"Notes" vorgemerkt ist - kénnen alle * . c-Dateien auch nebeneinander oder untereinander angezeigt
werden. In der AVR_PB_LED. txt-Datei kann das Projekt unter "Notes" detailliert beschrieben werden
- das soll uns hier aber noch nicht interessieren.

Wenn die Felder nicht gleich so erscheinen, wie sie im Bild 2.1.1-12 dargestellt sind, so ist zu bemerken,
dass die Felder - wie in anderen Anwendungen auch - minimiert, maximiert oder "gezogen" werden
kdénnen, was hier geschehen ist.

Um Platz fur die Quelldateien zu schaffen, werden jetzt die Spalten Function Call Tree, Code Temp-
lates und Clipboard History zunachst entfernt (siehe Bild 2.1.1-12) und die "File Pane" verbreitert:

CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LED.prj — IEl Iil
J Flle Edit Search View Project Took Settings Help ‘
Ibepg-BEdde M ERE. -t R X B|ES|EE /%% o-e-2 2|BBxB|H.
[ soAL (B 12RON0 EEEE B BN 4480, Ratas.] N6,
R R EET = ==
&= Code Navigator w 2| kg L@ a [ B_LED PB_LED bt
=5 CodsisionavR
= Project AvR_PE_LED
MNotes
-1 application.c

main.c

H @ Headers

El@ List Files éjﬁbﬂ

B AVR_PB_LED.asm @
[ AvR_PB_LED.Ist

5 B AvR_PBE_LED.map
LB Other Files

H Messages w5
B Enors | B Warningsl

| |

|| | Insert |

Bild 2.1.1-13: Verbreiterte "File Pane"
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Mit ein wenig Jonglieren werden die Spalten gestaltet:

1. Spalten nebeneinander
2. Offnen von main.c im Code Navigator
3. Offnen von application.cim Code Navigator

Wie man sieht, kann man im groRen Fenster noch eifrig alle Quell-Dateien verandern/editieren. Als
erstes wird die Gelegenheit genutzt, dem Projekt eine Kurzbeschreibung in den Project Notes voran-
zustellen. Es wird einfach ein Text in das dafiir vorgesehene Datei-Feld eingetragen:

CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LED.prj —|o|x|
| Fie Edit Search View Project Toos Settings Help |
== *E*Eﬂﬂ\%|©"©‘—»<—|@%‘x'@|i-%.
JMMN#’MM.J G SIEEHES RN ES LT NEE 1L E

|omH1 =8 @%l_mu_- =
f&- Code Newvigator v E@d 6| WE_PE_LED bt
B- ACVR CodevisionAvR
B- @ Project AvR_PE_LED
75 Notes
[ application.c

Notes * o

Erstes AVR-Projekt: -
Gezeigt werden der Einsatz von Tastern und
das -Schalten von Ausgaengen. Jeder -der -drei

o wverwendeten Taster steuert eine LED an:
: Headers

E@ ListFiles

B AVE_PB_LED.asm
AVE_PBE_LED.Ist
B AvR_PB_LED.map LED2 ist dauerhaft an und erlischt,

'”Eﬁ Other Files solange Taster 52 gedruesckt ist. e

Taster 51 schaltet LED1 ein,
solange der Taster gedrueckt ist.

Taster 53 -schaltet bei  jedem Tastendruck
die LED3 um  ('toggelt' -sie).

Das ueberschaubare Projekt ist fast eine
"Hello, World!"-Anwendung und ist gut
geeignet, um die im Tutorial eingesetzten

Ressourcen zu verdeutlichen.
§§ v|

H Messages w & @
E Errars | B Wamingsl

18:29 | Modified | Insert |

Bild 2.1.1-14: Kurzbeschreibung des Projektes

CodcVisonAVR 1:\AVR_BB,_LED\AVR BB LED.prj =0l

Y Y ¥ ngb:txw G- 8

2 Emwd ]

=
& Ever | B wnis]

T30 [ et Goote formabon oy b pioorgieie, o e e sl Cormpbl et

Bild 2.1.1-15: Die *.c-Dateien sind bereit zum Editieren (BildvergroRerung)
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JFIe Edit Search View Project Tools Setljngs Help

Do HegdE Jnn\éﬁhhﬁKﬁléI«Eﬂ)x\“p\@-'@v@..@léé
JM““#?*;BE!?-J&”!%& . E
IR |'@“e¥@%!_m|ll |

fe Code Mavigatar %]

F\VR

B ,W Y CodevisionAvR

. Hotes  main.c &
a @ Praject AVF_PB_LED B F(} Funmns
i g Notes L app_initfvoid) L&/
application.c - #} app_set_watchdog_prescalen 2
main.c g
Headers 4 AR AR AR R R AR Rk d% 601 AVR C Projekt FB LED
ListFiles F
H AR PB_LED.asm 6 B T LR I
AWR_PB_LED st q
“ [l AVR_PB_LED.map g
@ Other Files a Projekt €01..........: Demonstration der Taster und LEDs auf dem Testboa.
10 Zusastzliche Header..: keins
11 Module. (*.c und *.h).: application
12 Benoetigte Hardware..: Testboard, Taster S1, 52, S3 und LED1, LEDZ, LED3
13 Version..............: 1.1
14 Compiler.... wee...: CodeVisiondVR
15 [ 2.5 - T ceesesi ATmegabl
16 Datum....... wee...: Juni 2009
17 PG T Alwin Lenck (ALE23) basierend auf dem Projekt FB
ie

Bild 2.1.1-16: VergroRRerung von Bild 2.1.1-15 - Projekt-Stand vor der Kompilierung

Bevor das Programm kompiliert wird, sollen vorher noch einige andere Listen zur Konfiguration des

Projektes genauer betrachtet werden. Dazu wird erst einmal das Konfigurations-Meni erneut aufgeru-
fen:

4" Configure Project AVR_PB_LED.prj

Files |G Compiler | Before Build | Atter Build |

Input Files  Output Directaries
Executable Files:

E

|Exe H
Ohject Files:
[ok] el
List Files
[List E
- - Linker Files:
CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LED.prj [cinker &

| Fle Edit Search View

Project. Tools Settings Help

Do HE@CB Ch ntax 4
a3 l:
JM B of 800 ||| "} Compie o §
*’ﬁ%| 1 ||F= |@Fﬁg °.Buid Shift+F9
f&: Code Navigator Buid Al Curt+F9 i
=8 E\'}‘,: CodeVisionAWR o Stop Compiation
B @ Project AVR_PE_ % Clean Up
Mates
applicationc | & Information
main.c
Headers B Go to Next Error £8
[ List Files B Go to Previous Error Ciri+F5
B AvE_FPB_LE r I
GO Lo Next Warnin F4
B AvVR_PEB_LE = J .
B AVR PE L B Go to Previous Warning  CtrizF4
----- [B OtherFiles Notes
B Export

&

X Cancel | ? Heln

Bild 2.1.1-17: Aufruf des Konfigurations-Menis Bild 2.1.1-18: Configure Project

Part 2 - Output Directories

Project => Configure => EAML A SaGNESCEREDTUE =~ Output Directories

In dieser Abbildung werden die Ausgabe-Ordner angezeigt, in denen bei der Kompilierung die Ergebnis-
Dateien abgelegt werden.
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Executable Files:
* _hex-Dateien vom Linker

Object Files:
* _obj-Dateien nach dem Lauf des Assemblers

List Files:
* _asm-Dateien nach der Kompilierung

Linker Files:
* _a- und *.o-Dateien zum Linken/Binden

<", Configure Project AVR_PB_LED.prj x|

Filss  CCompiler | Before Build | After Build |

Cade Generation |Libraries| Messagesl Glnbﬁlly#definel Paths |

) —RAM
Chlp:lATmegaSS LI
Data Stack Size: 256 bytes
Clock: |16,000000 'ZIMHZ
Heap Size ID bytes
Mermony Model: Internal FRAM Size:  [1024 bytes
ISmﬁII vl
Optimize far:
ISIZB jv —Code Generation
Optimization Level: Bit Variables Size |1 E- II_ Use GPIOR »31

IMaximal vl [~ Promote chartoint  [v charis unsigned

Pragram Type [~ &hbitenums [ Enhanced Par Passing

IA lication vl
PP v Autormnatic Glohal Register Allocation

(s)ptintf Features: [v Stare Global Constants in FLASH Memany

Iint wiclth 'l [~ Use an External Startup Initialization File

(s)scant Featuras: [v Clear Global Variahles at Pragram Startup

Iint width - l [~ Stack End Markers

File Output Format(s): | ©OF ROM HEX EEP

—Freprocessor

[v Create Preprocessor Output Files

v Include /0 Registers Bits Definiions

o 0K X Cancel ? Help |

C¥ CVAVR_502.docx 14.03.2020

M o KINGSTON (L:)
ALEs_ASM_Progs
= AVE_PB_LED

Exe
Linker
List
Obj

Bild 2.1.1.-19: Configure Project
Part 3 - Code Generation

Hier kdnnen Einstellungen fur den Chip und
den Compiler zur Generierung der Ausgabe-
Dateien vorgenommen werden. Die Einstel-
lungen werden wie angegeben vorgenom-
men. Besonders zu beachten sind:

Chip: ATMega88

Clock: 16 MHz

Program Type: Application
Data Stack Size: 256 bytes

Heap Size: 0 Bytes

Internal RAM Size: 1024 bytes
Bit Variable Size: 16
Use GPIOR>31 nicht gesetzt

File Output Format(s):

Formate der Ausgabe-Dateien (hier ist vor-
rangig das Format HEX fir ein ausfiihrbares
Programm von Interesse).
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4 - Configure Project AVR_PB_LED.prj

"Flss  CCompiler | Before Build | Atter Build |

Code Generatlonl Libraries Messages |Globally#def|ne| Paths |

[¥ Enakle Warnings

Warnings

[T constant out of range

™ possible loss of precision

V! array index is out of range

V¥ RAM location address is out of range

! intarruptvactar exceeds the allowable range
¥ constant not initialized

¥ suspicious pointer conversion

V! register is already allocated

W macro was radefined

! function must hawe & return value

V! unused function was remaoved by the linker

V! function parameter was not referenced

¥/ function parameter name doesn't match its previous declaration
! lacalvariahle was declarad, but not referencad
! Incal variahle set. but not used

¥/ lacal variahle is used befare its value is set

[ global varnablefconstant was declared, but not referenced
! lahel declared, but nat referanced

W empty line

V! expression with possibly no effect

¥ unknown escape sequance

[ shift resultwill ba D

W overlowis possible in 6 kit addition

W overlow is possible in & bit multiplication

V! ovedlow is possible in B hit shift |eft

M overflow is possible in 16 bit addition

W overlow is possible in 16 bit multiplication

W overlow is possible in 16 bit shitt |eft

V! possibly incarrect assignment

V! pointless integer comparison

¥ contralling expression is constant
o R S Y E

|»

v DK | X Cancel |
<", Configure Project AVR_PB_LED.prj x|
‘Files  CCompiler |Elef0re Elundl Af'terElwIdl . . . .
Code Generat\onl Libraries' Messages' Globally #dafine  Paths | Elalg g?;ati]é Conflgure PFOJeCt
#include paths (one per ling):
cveviine Hier kdnnen neue Pfade fiir zuséatzliche #in-
clude- und library-Dateien angelegt werden:
#include paths (one per line):
fur globale Header-Dateien
Library paths (one per line):
fur Bibliotheksdateien
ey peiie (E0e pes e Fiir die hier generierten AVR-Projekte wird
ChovaraZilib von dieser Méglichkeit kein Gebrauch ge-
macht.
Mit OK wird das Mentl verlassen.
é W  OK | X Cancel ? Help
C¥ CVAVR_502.docx 14.03.2020 Seite 15 von 38

Bild 2.1.1.-20: Configure Project
Part 4 - Messages

Das ist die Liste Messages, in der man ange-
ben kann, welche Hinweise und Warnungen
man erhalten mochte.

Das Setzen bestimmter Warnungen kann
beim Testen sehr hilfreich sein, um unerreich-
baren Code anzuzeigen oder davor zu war-
nen, dass Variable deklariert sind, die gar
nicht benutzt werden.
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2.1.2 Ein C-Projekt generieren

—10 x|
‘QOU | N =] 3 | AVR_PB_LED durchsuchen @‘
| Datei Bearbeten Ansicht Extras 2 hd
Organisieren ¥  Freigeben fir ¥  Brennen  Neuer Ordner = ~ G
- Favoriten Name = GroBe | Anderungsdatum | Typ | |
« Nicht angegeben (14)
- Desktop | Exe 11.10.2012 09:58 Dateiordner
_ Bibliotheken
L?‘.b ALE | Linker 11.10.2012 09:58 Dateiordner
A Computer | List 11.10.2012 09:58 Dateiordner
€ Netzwerk | Obj 11,10.2012 05:58 Dateiordner
[53 Systemsteuerung application.c 11 KB 15.08.2009 14:17 C compiler source fie
% Papierkorb application.h 36 KB 15.08.2009 21:34 H-Datei
& AVR_PB_LED.prj SKB 11.10.2012 10:30 CodeVisionAVR Proj...
AVR_PB_LED.prj~ 4KB 11.10.2012 09:58 PRI~-Datei
ﬂ AVR_PB_LED.txt 1KB 11.10.2012 10:30 Text Document
iomx8.h 46 KB  15.08.2009 15:08 H-Datei
macros.h 4KB 15.08.2009 20:07 H-Datei
main.c 6KB 15.09.2012 21:58 C compiler source file
switches.h 4 KB 15.08.2009 20:09 H-Datei
typedefs.h 9KB 15.08.2009 20:13 H-Datei
l 14 Elemente
|14 Elemente | |A Computer ;

Bild 2.1.2-01: Ausgangslage zur Kompilierung - Stand der Dateien

€¥ CVAVR 502.docx
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CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LED.prj

Fle Edt Search View Project Tools Settings Help

Do HEddEE

BERs. - iena BlE-c s %le-0- 02 BExEH.

Ll - O

[t 2ROL[O/EEEE|S S,

IEIT REE TN

|68 %20,

ERE YR EE =R
iz Code Navigator 2 2 ||k Code Information ¥ # &

= 5 CodeVisionAvR EREY =inc " a3 =
2§ Project: AVR_PB_LED E-Fi Functions Sy -
. .18 Notes 41} mainfvaic) 1|E/* Al
O spplicatione 3
3
4 £01_AVR C_Projekt PB_LED
B ListFiles E
B AVR_PB_LED.asm E main.c :
[ AVR_PE_LED lst 1
[ AVR_PB_LED.map E
{8 OtherFiles of || Projext so1.. : Demonstration der Taster und LEDs auf dem Testboard
10| || Zusastzliche Header..: keine
11 Module. (*.c und *.h) application
12 Benostigte Hardware. 52, 53 und LED1, LEDZ, LED?
13
14|| Compiler.. : CodeVisionAVR
15 || cnip. ..: ATmegaga
16 . : Juni 2009
17 . Alvin lenck (ALE23) basierend auf dem Projekt PE LED von Udo Juerss
18
19
20| ||pieses Projeks stellt eine Applikation zur Demonstrabicn der Taster (Pushbottons) und LEDs auf dem Testboard dar.
21| |Die Taster sind nicat entprellt!
2
23| |pie LEDI ist im Runezustand AUS
24|||Die LED2 ist im Runezustand EIN
25 Die LED3 toggelt beim Betastigen der Taste 53 von AUS nach EIN und umgekehrt
26
2
28| |In der Header-Datei application.h kosnmen die Definitionen fuer die Tasten und LEDs geasnders werden.
29| |Die Definitionen sind hier wie folgt festgelegt:
30
31| | | romponente: ATmega1s-Pins:
32| ||##+ LEDs
33 LED1 PC2 (kann in application.h geaendert werden)
34 LEDZ PC3 (kann in application.h geaendert verden)
35| |zEDs PC4 (kann in spplication.h geaendert verden)
36
37| |#++ Taste
38 S1 PB3? (kann in application.h geasndert werden)
39| |s2 PB4 (kann in spplication.n verden)
a0 ||ss PBE (kann in application.n verden)
||+
w2l |/
43 // Header-Dateien einfuegen:
al s
45| [$include "application.nw
15
a1l s
48 // Globale Variablen:
a3 |2/
so| [vos
51
52 |//
53 // mai.
s |//
55 (void main(void)
56
57 // Setzen des System-Taktes (CPU-Clock), Ausschalten nicht benutzter Hardware-Module
se app_init(}; // Initialisierung der Anvendung
59
60 // Initislisieren der Tascen ( _
P s1_trT();
62 S2_INIT();
63 S3_INIT():
64
&5 // Initialisieren der LEDs
66 LEDL DDR |- LED1 BIT; EDI-Pin auf Ausgabe
& LED2_DDR |= LED2 BIT: LED2-Pin auf Ausgabe
68 LEDS_DDR |= LED3 BIT; ED3-Pin auf Ausgabe
69
70 // Alle LEDs 3-mal aufleuchten lassen ("Lampen-Test")
7 for (n = 3; n; n--)
72 {
73 LEDL_PRT |= LED1 BIT:
74 LED2_PRT |- LED2_BIT;
75 LEDS_PRT |= LED3 BIT;
76
77 delay_ms (250);
78
79 LEDL_PRT &= ~LEDI_BIT: // LEDL auf aUS
80 LED2_PRT &= ~LED2_BIT; // LEDZ auf AUS
£ LED3_PRT &= ~LED3_BIT; // LED3 auf avus
82
83 delay_ms (200);
24 ¥
&5
8s|||//
87||// Bauptscnieite
es||//
89 while (true) // Endlosschleife
90 {
81 // Wenn Taste §1 gedrueckt LEDL
92 if (S1_PRESSED()
93 {
94 LEDL_PRT |= LEDI_BIT: // LEDL auf EIN
95 ¥
9 else
97 i
9 LEDL_PRT &= ~LEDL BIT; // LEDL auf AUS
93 ¥
100
101 // Wenn Taste S2 gedrueckt wird, dann schaltet LEDZ auf AUS
102 if (S52_PRESSED())
103 {
104 LEDZ PRT &= ~LED2_BIT: // LED2 auf aUS
105 ¥
106 else
107 i
108 LED2_PRT |= LED2_BIT: // LEDZ auf EIN
109 ¥
110
111 // Wenn Taste S9 gedrusckt wird, dann toggle L
112 if (S3_PRESSED())
113 i
114 LED3_PRT “= LED3_BIT: // Toggle LED3
115
116 S53_WAIT_NOT_PRESSED(): J/ Warte bis Taste S3 losgelassen vird
117 ¥
118 '
119 ¥
20| |7/
151 AI_I
4
E Messages v Zd|
& Erors | B waringe
119:98 | | Insert  |Code Information may be incomplete, as the fie was not Compled yet

Bild 2.1.2-02: Ausgangslage zur Kompilierung - Hauptprogramm (BildvergréRerung)
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Die Ausgangslage fur die Kompilierung sind in einem C-Projekt die sog. Quell-Dateien. In diesem Pro-
jekt sind das:

e Das Hauptprogramm main.c

e Das Modul application.cincl. application.h
e Die Header-Datei typedefs.h

e Die Header-Datei iomx8.h

¢ Die Header-Datei macros.h

o Die Header-Datei switches.h

Aus ihnen entsteht in grundsatzlich 4 Arbeitsschritten das fertige "Kompilat", das heif3t die ausfiihrbare
* _hex-Datei:

1. Arbeitsschritt "Lauf des Preprozessors": Auswerten aller Anweisungen, die mit # beginnen. Das
sind Anweisungen, die ausschlief3lich fir den Preprozessor bestimmt sind (u. a. Einfligen von Header-
Dateien, die mit #include "file" in den Quell-Dateien aufgefihrt sind.

2. Arbeitsschritt "Lauf des C-Compilers" zur Ubersetzung der in der Programmiersprache C ge-
schriebenen Befehle in Assembler-Anweisungen => * . asm-Dateien (dieses sind ebenfalls editierbare
Text-Dateien).

3. Arbeitsschritt "Lauf des Assemblers" zur Ubersetzung der Assembler-Anweisungen in Maschi-
nen-Befehle (Module im Objekt-Code) => * . a-Dateien und * . o-Dateien

4. Arbeitsschritt "Lauf des Linkers (Binders)" zur Verbindung aller Objekt-Module zu einem lauffa-
higen ausfihrbaren Computer-Programm => * _hex-Datei

In CVAVR kann das C-Projekt sequentiell, d.h. in Einzel- bzw. Stufenschritten, generiert werden:

Project => Compile (F9) Dieser Schritt produziert die Objekt-Dateien fiir den Linker. Die
Kompilierung wird nur fiir die nach dem letzten Durchlauf verén-
derten Programm-Module durchgefiihrt.

Project => Build (Shift+F9) Dieser Schritt produziert ein neues Assembler-Quell-Pro-
gramm mit der Erweiterung *.asm wobei nur die veranderten
Quell-Dateien neu kompiliert werden. Wenn keine Fehler er-
kannt wurden, wird automatisch der Atmel-AVR-Assembler
aufgerufen, der die eben erzeugte . asm-Datei assembliert. Das
Ausgabe-File ist eine ausfuhrbare Programm-Datei mit dem For-
mat * . hex.

Project => Build All (Ctrl+F9) Vollstandige Kompilierung/Assemblierung/Verlinkung aller
Quellen; Zusammenfassung aller Arbeitsschritte zu einem Ar-
beitsgang.

Da das Projekt bereits an anderer Stelle getestet wurde, sind keine Fehler (mehr) zu erwarten, so dass
sofort mit dem Schritt Build All (Ctr+F9) fortgesetzt wird:

CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LED.prj

J File Edit Search View ,Project Tools Settings Help

is Eys'ﬂ?ﬁfﬁé@n Check Syntax ' 2R X B|ISEE/ A || e-0-0 2 BB B,
@4 7 1 gp @ ||| Y Compie S, 420, Sadsa.|? 4 @.
EEEIREC s Shift+F9

F= Code Nawvigatar P suid A ey CUtFS [ R PB_LEDymain.c

26 CodevisionavR | & 5t0p Compiand — -
=M Project AVR_PB_ Y. Clean Up Elegp/ mainc
I =] Motes 1 |L|:-“ J*

Bild 2.1.2-03: Project => Build All (Ctrl+F9)
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Wenn die vollstandige Kompilierung fehlerfrei (aber wahrscheinlicht nicht kommentarlos !) gelaufen ist,
werden Uber dem Haupt-Fenster von CVAVR zwei Informations-Listen am Ende der Projekt-Generie-
rung offeriert. Sie zeigen die Ergebnisse fir die Kompilierung und die Assemblierung.

CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_LED.prj ;Iglil

Fe Edit Search View Project Took Settings Help |
DS HEFCEDMERE.] - [t R B E[EE /Y% 0w -8 2[E B x Ft.]
BE P A® (B 12200 EREEE S hA.sevn0.[Tassa.[226.
R TR E EEEN

E Code Navigator < % 3| [%g) Codle Information v 5d|
=&Y CodeVisionAvR E-0 mainc
B Praject AVR_PE_LED 5B ncludes otesy) main. (& -
78 Notes application.h - =
[ application.c =¥ Global/Static Variables z
- Wamings X n>Rd 3
N mainc = F{) Functions 4 €01_AVR C Projekt_PE LED
B Headers 0 mainfvoid) E
application.h s main.c ** Vi.1
cypeh K
8

stration der Taster und LEDs auf dem Testboard

, Taster S1, 52, S3 und LED1, LED2, LED3

egalfd_bitsh 13| || versien.
megaBih 14 Compiler. . CodeVisionAVR

ieses Projekt stellt eine Applikation zur Demenstration der Taster (Pushbottons) und LEDS zuf dem Testhbozrd dar.

ie Taster sind nicht entprellt!

B AvR_PB_LED ssm 22
AvP_PE_LED.Ist 3

AVR_PB_LED map 2¢ t nd EIL S
@ Other Files 25 D3t elt beim Betaetigen der Tast: n h EIN und umgekehrt
26 LI
Messages v 2 d|
£l
B Erors B Wamings
\Warning: L\AVR_PB_LED\ioms8.h{41). inclucled fram: typedefs h: macro 'UMSELDT was redefined i’
\Warhing: L\AVR_PB_LED\ioms8.h{42). inclucled from: typedefs.h: macro 'UMSELDD' was redefined

\Warning: L\AVR_PB_LED\ioms8.h43), incluled from: typadefs h: macro "UPMO1* was redefinedt
\Warning: L\AVR_PB_LED\ioms@.h{44), included from: typedefs.h: macro "UPMOD' was redefined
\Warning: L\AVR_PB_LED\iomsB.h{45), included from: typedefs.h: macro 'USBS0! was redefined
\Warning: L\AVR_PB_LED\ioms®.h{46), included from: typedefs.h: macro "UCSZ01" was redefined |

119:98 | | insert |

Bild 2.1.2-04: Nach der Kompilierung mit Build All (Ctrl+F9) (BildvergréR3erung)

EA|IW i 1nformation x|

i InformgZion

Compiler Compiler Assambler

Chip: ATmegad8 ANVBASK: AVR macro assembler 2.1.30 (build 592 Now 7 2008 12:38:17)
Clock frequency: 16.000000 kHz Copyright (T 1995-2008 ATMEL Corporation

Program type: Application

temory model: Small LiavR_PB_LEDListyAWR_PB_LED. asm(1659): Mo EEPROM data, delet
Optimize for: Size

(s)printf features: int, width ATmegadd memory use summary [bytes]:

(s)scanf features: int, width Segment Begin End  Code Data Used Size Use¥:

Frarmate 'char' ta int': Mo

‘char' is unsigned: Yes [cseq] 0x000000 00016 326 38 364 8192 4.4%

global 'const' stored in FLASH: Yes [dseg] 0x000100 0x000205 O 5 &5 1024 05&%

8 bit enums: Mo [eseq] 0000000 0x000000 0O 0O 0O 512 0.0%

Enhanced function parameters passing: No

Automatic register allocation: Yes Azsembly complete, 0 errors.

Smar register allocation: Yes Q

Build: 1
15441 line(s) compiled

Mo errors
604 warnin@
Bitwariahles size: 0 byte(s)

Diata Stack area: 0x100 to 0x1FF
Data Stack size: 256 byte(s)
Estimated Data Stack usage: 0 byte(s)

Fiakd Global variables ares: 0x200 to 0x204
Fakd Global variables size: 5 byte(s)

Hardware Stack area: 0x205 to OxdFF
Hardware Stack size: 763 byte(s)

Heap size: 0 byte(s)
EEFROM usage: 0 bntels). 0.0% of EEFRONM

Frogram size: 182 words (364 bytes), 4.4% of FLASH
Owards (0 bytes), 0.0% reduced by Code Compressian

Bild 2.1.2-05: Compiler-Meldungen Bild 2.1.2-06: Assembler-Meldungen
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Wenn man tiefer in die Materie eingestiegen ist, so geben diese Listen sehr aufschlussreiche Hinweise
zum Kompilat und den benutzten Ressourcen (Speicher-Belegungen). An dieser Stelle moégen die Hin-
weise

No errors und Assembly complete, 0 errors.

genilgen. Sie zeigen an, dass das Projekt fehlerfrei kompiliert und assembliert wurde und ein ablauffa-
higes Objekt-Programm erzeugt wurde.

2.2 Dateistruktur eines C-Projektes

Das folgende Bild stellt die ineinander greifende Struktur des oben beispielhaft gewéhlten C-Projektes
dar. Die Verschachtelung ergibt sich aus den Quell-Dateien. Weitere Informationen hierzu folgen in Teil
503 - Der Preprozessor, Teil 504 - Syntax der C-Programmiersprache und Teil 505 - Modularer
Aufbau der AVR-Projekte.

C-Dateien:
main.c, application.c

Header-Dateien:
application.h, typedefs.h, iomx8.h, macros.h, switches.h

Globale Header-Dateien vom CVAVR:
mega88.h, delay.h, stdio.h, starg.h, stdlib.h, string.h, ctype.h, limits.h

main.c application.c
Einflige-Pfeile
#include "application.h" #include "application.h"
Initialisieren der Tasten und LED's Setzen der Taktfrequenz,
Hauptschleife mit der wiederholten ggf. Warnungen ausgeben,
Abfrage der Tasten Setzen der Tastschalter,
Register zurlick setzen

application.h

typedefs.h O

#include "typedefs.h"

" o veranderbaren Parameter,
#include <stdlib.h> nicht benétigte Module werden

durch // auskommentiert

1
! |
! 1
1
: $iniclude <stdic. h> 1 Definition der im Projekt, :
. - | !
! I
I 5 I
 #include <ctype.h> : I
1 #include <delay.h> = = | [ | ==~ !
—»: #include <string.h>
—— #include <limits.h>
: #include "iomx8.h"
| #include "macros.h"
]
l
]
1
l
L

#include "switches.h"

Definition der spezifischen
Hardware vom ATmega88

zu bestehenden Datentypen
(Typendeklaration)

|
I
Definition aquivalenter Namen :
I
I

: Definition der Funktion(en) Definition der Funktion(en) |

| zur Verzdgerung schnell | | zur Standard-Eingabe und ! 0r156_9§§8_-11 ______ .
| ablaufender Vorgénge | | -Ausgabe von Zeichen ! | |
1 [ e B ! | Definition der controller- |
o i ! | spezifischen Register,
| Ports, Timer usw. 1
(R b e e | !
. Definition von Makros zur |
—Ostzing.h _____ : Behandlung variabler |
1 I | Argumenten-Listen ! L Omacros.h
| Definition der Funktion(en) ! L — — = — — — — — — — — _ | e e s i
: zum Verknipfen, : | 1
Vergleichen, Kopieren : o | Definition anwendungs- |
: usw. von Strings : stdlib. hO————— : spezifischer Makros !
|

L | ! . 1
———————————— I Definition der Standard- | o e i e

: Bibliotheks-Funktionen

| s
) et —————Oswitches.h

—Olimits.h ______ )switches.h ____ ;
! | type.h O————— ' I
: Definition der : il s il m— i { Definition der Tastschalter- |
; Minimum- und Maximum- | : Definition der Funktion(en) 1 | Makros 1
,  Werte von Dateitypen | zum Testen von Zeichen- | | |
\ des Controllers : i Typen o e e

Bt it et !
Richtung der Einfligung

Bild 2.2-01: Datei-Struktur des Projektes AVR_PB_LED (BildvergréRerunq)
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Am Ende der Kompilierung sieht der Projekt-Ordner schon viel verwirrender und viel gefullter aus:

:\AVR_PB_LED

=10] x|

[C1e1

j @ll AVR_PB_LED durchsuchen \g‘

| Datei Bearbeten Ansicht Extras 2

Organisieren ¥

Freigeben fir

Neuer Crdner

Name “

Grobe

|ﬁnderungsdatum |Typ | |

. Favoriten
< Nicht angegeben (24)
— Desktop | Exe 11.10.2012 09:58  Dateiordner
_ | Bibliotheken
L?t ALE | Linker 11.10.2012 09:58  Dateiordner
‘A« Computer | Lst 11.10.2012 09:58 Dateiordner
€ Netawerk | 0bj 11.10.2012 09:58  Dateiordner
|55 Systemsteuerung application.c 11 KB 15.08.2009 14:17  C compier source fie
% Papierkorb application.cci 1KB 11.10.2012 10:46  CCI-Datei
application.h 36 KB 15.08.2008 21:34 H-Datel
application.ha 1KB 11.10.2012 10:46 HCI-Datel
@ AVR_PB_LED.pr] 6 KB 11.10.2012 10:47 CodeVisionAVR Project File
AVR_PB_LED.prj~ 6KB 11.10.2012 10:41 PRI~-Datei
Z AVR_PB_LED.txt 1KB 11.10.2012 10:30 Text Document
iomx8.h 46 KB 15.08.2009 15:08 H-Datel
lomx8.hci 11 KB 11.10.2012 10:46 HCI-Datel
macros.h 4 KB 15.08.2008 20:07 H-Datel
macros.hci 1KB 11.10.2012 10:46 HCI-Datel
main.c 6KB 15.09.2012 21:58  C compier source fie
switches.h 4 KB 15.08.2008 20:09 H-Datel
switches.hd 1KB 11.10.2012 10:46  HCI-Datei
typedefs.h 9KB 15.08.2009 20:13  H-Datel
typedefs.hci 4KB 11.10.2012 10:46  HCI-Datei
main.cci 1KB 11.10.2012 10:46  CCI-Datei
AVR_PB_LED.fct 1KB 11.10.2012 10:46  FCT-Datei
AVR_PB_LED.chi 1KB 11.10.2012 10:46  CBI-Datei
AVR_PB_LED.cof 4KB 11.10.2012 10:46  COFF symbolic debug file
‘ 24 Elemente
|24 Elemente ‘ ‘A Computer ;

Bild 2.2-02: Die Quell-Dateien und wéhrend der Kompilierung angelegte Zwischen-Dateien
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(o] x|
*ou?‘vl [ \AvR_P5_LED\Unker ﬂ [@jl Linker durchsuchen @l

| Datel Bearbeiten Ansicht Extras 2

Organisieren >  Freigeben fir *  Brennen  Neuer Qrdner > j iﬁl
- Favorten Name = Gribe | Anderungsdatum | Typ | |
« Nicht angegeben (14)
— Desktop application.a 14KB 11.10.2012 10:46  A-Datel

.| Bibliotheken )} i

B ALE application.o 33KB 11.10.2012 10:46 O-Datei

A Computer ctype.al S9KB 11.10.2012 10:46 AL-Datei

@ Netzwerk ctype.ol 23KB  11.10.2012 10:46 OL-Datel

Eﬂ Systemsteuerung main.a 10KB 11.10.2012 10:46 A-Datel

i Papierkorb main.o 33KB 11.10.2012 10:46  O-Datei
math.al 34KB 11.10.2012 10:46 AL-Datei
math.ol 45KB 11.10.2012 10:46 OL-Datei
stdio.al 37 KB 11.10.2012 10:46 AL-Datei
stdio.ol 46 KB 11.10.2012 10:46 OL-Datei
stdib.al 33KB 11.10.2012 10:46 AL-Datei
stdib.ol 51KB 11.10.2012 10:46 OL-Datei
string.al 40 KB 11.10.2012 10:46 AL-Datei
string.ol 37 KB 11.10.2012 10:46 OL-Datei

l 14 Elemente

14 Elemente | 1A Computer ;

Bild 2.2-03: Die Linker-Dateien

=10l x|
‘@le | j [gj| List durchsuchen @'

| Datei Bearbeten Ansicht Extras 2

Organisieren ¥  Freigeben fur *  Brennen  Neuer Ordner

- Favorten Name « GroBe | Anderungsdatum | Typ | |
4 Nicht angegeben (3)
M Desktop #| AVR_PB_LED.asm 40KB 11.10.201210:46  Assembler source fie
.| Bibliotheken
n AVR_PB_LED.Ist J0KB 11.10.2012 10:46 List file
k2 ALE
‘A« Computer AVR_PB_LED.map 2KB 11.10.2012 10:46 C compiler map file
@ Netzwerk
[ systemsteuerung
5 Papierkorb
L |
I 3 Elemente
|3 Elemente ‘ ‘A Computer y

Bild 2.2-04: Die List-Dateien
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M L:\AVR_PB_LED\Obj —O] x|
k’(:)ﬂu L:\AVR_PB_LED\Obj jl@ﬂ O durchsuchen @‘
| Datel Bearbeiten Ansicht Extras 2

Organisieren ¥ Freigeben fiir ¥  Brennen  Neuer Ordner = ~ ] @

- Favoriten Name = GroBe | Anderungsdatum | Typ | |

« Nicht angegeben (10)

B Desktop

) application.strl 1KB 11.10.2012 10:46 STR1-Datei
. Bibliotheken
)13 ALE application.sym1 2KB 11.10.2012 10:46 SYM1-Datel
;l; e — application.sym2 1KB 11.10.2012 10:46 SYM2-Datei
G Netzwerk application.sym3 1KB 11.10.2012 10:46 SYM3-Datei
[25 Systemsteuerung AVR_PB_LED.cof 4KB 11.10.2012 10:46 COFF symbolic debug fie
% Papierkorb AVR_PB_LED.obj 2KB 11.10.2012 10:46 Atmel object fie
main.strl 1KB 11.10.2012 10:46 STR1-Datei
main.syml 1KB 11.10.2012 10:46 SYM1-Datei
main.sym2 1KB 11.10.2012 10:46 SYM2-Datei
main.sym3 1KB 11.10.2012 10:46 SYM3-Datei
L LB
J 10 Elemente
|10 Elemente | sy Computer v
Bild 2.2-05: Die Obj-Dateien
M L:\AVR_PB_LED\Exe -|oj x|
—
‘ok_)ﬂ L:\AVR_PB_LED\Exe j @I Exe durchsuchen \@‘
| Datei Bearbeten Ansicht Extras 2
Organisieren ~  Freigeben fiir *  Brennen  Neuer Ordner = ~ ]l @
- Favoriten Name = Grobe | Anderungsdatum | Typ | |
< Nicht angegeben (2)
B Desktop @ AVR_PB_LED.hex 2KB 11.10.201210:46  HEX-Datei
- Bibliotheken
'B ALE AVR_PB_LED.rom 3JKB 11.10.2012 10:46 Atmel FLASH contents file
‘A Computer
€ Netzwerk
[i5 Systemsteuerung
a: Papierkorb
L LB
J 2 Elemente
|2 Elemente \ \A Computer ;

Bild 2.2-06: Die Exe-Dateien

Die Datei AVR_PB_LED. hex ist schlieRlich die Datei, die in den Controller geflasht und dann zum Lau-
fen gebracht wird.

2.3 Einbindung von AVR Studio in den CVAVR

Hinweis: Wer gleich ins "Volle" gehen will, der kann bei 2.5 C-Compiler-Optionen (Arbeiten mit dem
CVAVR) gleich weiterarbeiten!

Der Compiler CVAVR ist daflr vorgesehen, mit dem Debugger vom AVR Studio ab der Version 4.13 zu
kommunizieren. Dazu ist es notwendig, die Lokalisation von AVR Studio, d.h. den Ordner-Pfad von AVR
Studio auf der System-Platte, der Anwendung CVAVR bekannt zu machen. Diese Lokalisation ist (unter
der Annahme, dass AVR Studio auf seinem "angestammten” Platz installiert wurde):
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C:\Program Files (x86)\Atmel\AVR Tools\AvrStudio4\AVRStudio.exe

Der Eintrag in CVAVR wird im Menl Debugger Settings vorgenommen:

CodeVisionAVR - L:\AVR_PB_LED\AVR_PB_| LED prj
JFie Edit Search View Fm]ect Tools | Settings Help

kRN E(SEE s
l@\l@nﬁvj&iﬁvgﬂ

JD'E'?H'FI b=
Jﬁﬂﬁmﬁesﬁ+st|§n=nﬂtE°%Ed[tﬂr )
o 1k e E D o | ¢

B: Cade Navigator v 7 0% Cod *¥ Erogrammer 5 3| | MYy NN s
E-Gon CodevisionAVR =09 1 & Terminal — —
=-[§ Project AvE_PE_LED - @i Includes e on.C
""" Motes - B applicationh 1|8/
=-0 application.c Xy Global/Static Variables 2| f|-—-———
- Wamings C X n->PRd f|--————————-————-
_____ . main.c EF{} Functions 4 B L
- Headers L mainfvoid) 3|
i H ﬂpp“l:ﬂtlljﬂh g e )
& ctypeh T |-
] delayh |
El . iomxa.h 9 Projekt &01.......

Bild 2.3-01: Debugger-Eintrag in CVAVR vornehmen

< Debugger Settings il

Debugger: Iﬂx‘foi Studio 419 ll

Directory and Filename: &» &z
IC;HF’ngram Files (xg6)\AtmelaVR Tools\AwrStudio AR Studio 'Fgl

? Help |

Bild 2.3-02: Einstellen der Datei AVRStudio.exe

Settings => Debugger => Debugger Settings => Directory and Filename:
C:\Program Files (x86)\Atmel\AVR Tools\AvrStudio4\AVRStudio.exe

=> 0K

Sollte AVRStudio. exe nicht an der vorgesehenen Lokalisation installiert worden sein, so kann sie mit

der "File-Such-Funktion" E gefunden werden:
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Debugger Directory and FileName il
Suchen in: I | AwvrStudio4 j Q2 Er
g Name = |'| GribBe |'| Anderungsdatum |v| Typ
~ Nicht angegeben (8)
ZUREEBESUCE | bin 06.09.2012 21:49 Dateiordner
D Lodl 06.09.2012 21:50 Dateiordner
Desktop | edit 06.09.2012 21:49 Date:n)rd ner
| resources 06.09.2012 21:49 Dateiordner
H | skins 06.09.2012 21:49 Dateiordner
Bibiothéken 'b- AVRStudio.exe 3.223KB 25.08.2011 21:05 Anwendung
ﬁPIuginManager.exe 55 KB 25.08.2011 20:58 Anwendung
I’ # |xmiconvert.exe 284 KB 25.08.2011 20:59 Anwendung
Computer
L | [

Dateiname: I é ﬂ Offnen
Dateityp: IExecutabIes (*.exe) LI Abbrechen |

Bild 2.3-03: Suchen der Datei AVRStudio.exe

Hinweis: Hier findet ein gleitender Ubergang zum nachsten Abschnitt statt. Man befindet sich scheinbar
noch in der Anwendung CVAVR. Denn aus dieser heraus wird der Debugger aufgerufen, der aber
schon Bestandteil des AVR Studio ist.

2.4 AVR Studio Debugger

Mit dem Debugger des AVR Studios kann man - bevor man den Objekt-Code des fertig kompilierten
Projektes in den Flash-Speicher des Mikrocontrollers tbertragt - Schritt fir Schritt den Programmablauf
simulieren.

CodeVisionAVR - L: \AVR_PB_LED\.&)!?_;PB_LED.ij
| Fle Edt sSearch View Project | Tools Settings Help

IDeg-H 8@ @ S| & CodewrardAVR  Shift+F2
[da 1t oap M|y oY gebugger \ka Shift+F3
J%‘ 1 ”E@p%f%%‘ﬁrchipgrogra Rer  Shift+F4

BAH|S|EE 7 |%|0-0-9 0|8 ExE|H.
TEEEE R T IVNE EE LT BEE

- Code Mawigatar =) & Terminal Shift+F5
o & CodevisionAVR [ LCD Vision Shift+F6
=-[3 Project AvR_PE_LED
8] Motes 4 Configure
application.c a2 |7
w-B Warnings 43| |// Header-Dateien einfuegen:

Bild 2.4-01: Aufruf des Debuggers zum Projekt AVR_PB_LED
Tools => Debugger (Shift+F3) => 06ffnet AVR Studio => File => Open File...(Strg+0)

Es startet AVR Studio (aus CVAVR heraus !):

Dabei wird ggf. das Startfenster mit einem Willkommensdialog gedffnet, wenn die Option Show this
dialog on open aktiviert war. Da nicht mit Assembler oder AVR GCC gearbeitet wird, sondern ein
AVR-Projekt mit CVAVR erstellt werden soll, wird das Hakchen bei Show dialog at startup entfernt -
und das Fensterchen erscheint zuklnftig nicht mehr.

Es ist zu beachten, dass bereits einige Optionen voreingestellt worden sein kénnen, so dass das Abbild
von AVR Studio nach der urspriinglichen Installation anders ausgesehen haben kénnte.
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1| New File strg+N | ) M g 36 6 L% T4 K8 =

AVR Studio
&

Project Build View Tools Debug Help

i
EE]
o
‘
a
g

|L_5 Open File... S, Strg+0 |

Close

e T dm ok e e n

A save Strg+S
Save As..
-+ 1# Save All
o
] 3 Print.. Strg+P
b
| @ Print Setup...
X Name Address ‘Value | Bits
<
[Z] Build ﬂMessage %Find in Files |iz_='38reakpoints and Trace.. |4 | | ﬂ
® CAP NL
Bild 2.4-02: Offnen des Datei-Dialogs
x|

OO [ A

v 23 | AvR_PB_LED durchsu... @‘

Organisieren ¥ Neuer Ordner

vl e

Name “ | GriBe | Anderungsdatum | Typ |
~ Nicht angegeben (25)

| Exe 23.09.2012 19:39 Dateiordner

| Lnker 23.09.2012 19:39 Dateiordner

. Lst 23.09.2012 19:39 Dateiordner

| 0bj 23.09.2012 19:39 Dateiordner
application.c 11 KB 15.08.2009 14:17 C compiler source fie
application.cci 1KB 23.09.2012 19:49 CCI-Datei
application.h 36 KB 15.08.2009 21:34 C compiler header fie
application.hd 1KB 23.09.2012 19:45 HCI-Datei
application.i 9KB 23.09.2012 19:49 C compiler library file
AVR_PB_LED.chi 1KB 23.09.2012 19:45 CBI-Datei

AVR_PB_LED.cof

AVR_PB_LED.fct 1KB
% AVR_PB_LED.prj 6 KB
AVR_PB_LED.prj~ 5 KB
iomx8.h 46 KB
iomx8.hci 11 KB
macros.h 4 KB
macros.hci 1KB
main.c 6 KB
main.cci 1KB
main.i 9 KB
switches.h 4 KB
switches.hd 1KB
typedefs.h 9 KB
typedefs.hci 4 KB

23.09.2012 19:49
23.09.2012 19:49
23.09.2012 19:50
23.09.2012 19:40
15.08.2009 15:08
23.09.2012 19:49
15.08.2009 20:07
23.09.2012 19:49
15.09.2012 21:58
23.09.2012 19:49
23.09.2012 19:49
15.08.2009 20:09
23.09.2012 19:49
15.08.2009 20:13
23.09.2012 19:49

COFF symbolic debug file

FCT-Datei
CodeVisionAVR. Project File
PRI~-Datei

C compiler header fie
HCI-Datei

C compiler header fie
HCI-Datei

C compiler source file
CCI-Datei

C compiler library file
C compiler header fie
HCI-Datei

C compiler header fie
HCI-Datei

Dateiname: |AVR_PB_LED.cof

=] [aiFies 65

[

é()ffnen | Abbrechenl
A

Bild 2.4-03: Suchen der COFF-Datei
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Die benotigte COFF-Datei befindet sich im Verzeichnis L: \AVR_PB_LED des Projekt-Ordners vom Bei-

spiel-Projekt AVR_PB_LED und hierher soll auch die Datei AVR_PB_LED. cof.aps abgespeichert wer-
den:

Save AVR Studio Project File x|
= o
SISRIN. - = ol v | k23| AvR_PB_LED durchsuchen @‘
Organisieren ¥  Neuer Ordner = - 9
Name « | Grobe Anderungsdatum | Typ | |
~ Nicht angegeben (4)
| Exe 23.09.2012 19:39 Dateiordner
| Linker 23.09.2012 19:39 Dateiordner
| List 23.09.2012 19:39 Dateiordner
| Obj 23.09.2012 19:39 Dateiordner
Dateiname: |AVR_PB_LED_c0f.ap5 <1 j
Dateityp: |AVR Studio Project Fles (*.aps) 4
~ Ordner ausblendenl Speichern Abbrechen |
é Y

Bild 2.4-04: aAvR_PB_LED.cof.aps Speichern

Es dauert einen Moment, bis man die Debug-Plattform AVR Simulator fiir den Mikrocontroller AT-
mega88 einstellen kann:

Select device and debug platform

- Select debug platform and device
Debug platiarm: Dewvice:
% AR Dragon ATmegaB4Cl -]
AR OME! ATmegabdhl
@ AR Simulatar ATmegal
® QS A%R Simulator 2 ATmegadhlh
’.Q ICE200 ATmeqags3s
Q ICE40 ATmegal
ICESD ATmegadis
JTAGICE ATmegadsP —1
JTAGICE kil ATmegaliPA
ATmegada
ATmegadHVA
ATmegallz |
[~ | Open platiarm aptions nexttime debug mode is entered

<< Back | [sleti>> |é‘ Finish | Cancel | Help

Bild 2.4-05: Debug-Plattform fir den ATmega88 einstellen

Nach einer weiteren kurzen Verweildauer 6ffnet sich AVR Studio mit der fir das C-Projekt
AVR_PB_LED eingestellten Debug-Plattform mit zahlreichen Toolbars, von denen besonders hervor-
zuheben sind:

e Prozessor-Daten (Counter, Pointer, Register usw.)

o Die aktuelle Quell-Datei D: \AVR_PB_LED\main.c mit einem gelben Pfeil auf die erste aus-
fuhrbare Anweisung

e Ein-/Ausgabe-Werte (I/O View; Hardware-Ressourcen)

e Nachrichten Uber die laufenden Aktivitaten (Message Output)

C¥ CVAVR_502.docx 14.03.2020 Seite 27 von 38



AVR-8-bit-Mikrocontroller
Gruppe 500 - CodeVisionAVR C-Compiler
Teil 502 - Aufbau eines C-Projektes

Jetzt "schiebt" man sich die Seiten der Felder so hin, dass eine verniinftige Ubersicht erscheint:

AVR Studio - L:\AVR_PB_|LED\main.c - |O 1]
¢ File Project Build Edit View Tools Debug Window Help
S A0 DA DRI MMs SR EE RN BTy B Qe EEENEHO S I GAEG
 |Trace Disabled |’ A = T
/O View - X
Name Value 2 [ [&] 5| AnALOG comparaT +
Program Cou... 0x000076 e |Va\ue ‘
void main({void
)Sc'a;:‘nr;'”'e’ xgzg; { fvord) 2 TDAD_CONVERTER
p /7 Betzen des System-Taktes (CPU-Cleck), Ausschalten nicht b + TYANALOG_COMPARATOR
Y pointer 0x0200 > app_init(): <7 Initialisii 4 BcrPuU
Z pointer 0x0004 B EEPROM
Cycle Counter 6287 #< Initialisieren der Tasten (Pushbuttons) 4
Freouens 40000 Mz S1INIT(): 4 SYEXTERNAL_INTERRUPT
St 52 INIT(; BlEdrorTE |
SFUEEG alc D]I:U[E]EI[B]EI S3_INIT(); PortB Data Register 0x00
E Z .
P ./ Tnitialisieren der LEDs PortB Data Direction Register 0x00
RO0 01 LED1_DDR |= LED1_EIT: /4 Setze LEDL PortB Input Pins 0x00
LED2_DDR |= LED2_BIT: <7/ Betze LEDZ BIElPORTC
2§; xgg LED3_DDR |- LEDI_BIT: /7 Setze LED3 Por C Data Register 000
RO3 500 ~/ Blle LEDs 3-mal aufleuchten lassen ("Lampen-Tast') Port C Data Direction Register  0x00
Ro4 000 for (n = 3: n: n--) Port CInput Pins 0x00
” : 4 2 PORTD
R05 000 LED1 PRT |- LED1 BIT; s+ LEDL auf E 4 29SPI
RO6 0x00 LEDZ_PRT |= LEDZ2_BIT; <7 LED2 auf E .
RO7 0x00 LED3_PRT |= LED3_BIT: <7 LED3 auf E 4
4 - -
:gg igg delay_ms(250); <7 250 ms Ver: + B TIMER_COUNTER_2
2TWI
R10 0x00 LED1_PRT &= “LED1_BIT; s« LED1 auf Al ?EEUSARTD
R11 000 LEDZ_PRT &= “LEDZ_BIT; 77 LEDZ auf Al e
R12 0x00 LED3_PRT &= “LED3_BIT: </ LED3 auf A&l 2 fic WATCHDOG
R13 000 delay_ms(200): 7 200 ms Ver
R14 00 7
R15 0x00
S o
R16 00 /+ Hauptschleife:
R17 0x00 L T
R18 0x00 while (true) /# Endlosschli
R19 00 il T 51 . k d, d 1 b LED1
<7 Wenn Taste gedrueckt wird, dann leuchtet
R20 0x00 if (S1_PRESSED()) Name Address |Va\ue |B\|5
R21 0x00 { ¥ DDRB 004 (0x24)  Ox00 OOOOOOOO
R22 58 LED1_FRT |= LEDI_BIT: ## LED1 auf E ZPINB 03 (x23)  x00 OOOOCOO0O
R23 000 glse = PORTB 0x05 (1x25)  0x00 OOOOOOO0
R24 0x00 { ¥ DDRC 07 (x27) 00 - OO00O000O
R25 000 LEDI_PRT &= “LED1_BIT: #/ LEDL auf & =PINC 1x06 (0x26)  0x00 1 O0ODOC0CO
R26 0x02 1 ZPORTC 08 (x28)  x00 - OO0C0O00O
R27 0x02
Ro8 000 s Wenn Taste 32 gedrueckt wird, dann schaltet LEDZ auf AL
if (S2_PRESSED())
R23 0x02 {
R30 004 LEDZ_FRT &= "LEDZ_BIT: <7 LEDZ auf A&l
R31 0x00
else
LED2_PRT |= LED2_BIT: <7 LEDZ auf E
<+ Wenn Taste 33 gedrueckt wird, dann teggle LED3 (EIN-AUS
if (S3_PRESSED())
{
LED3_FRT ~= LED3_BIT: s« Toggle LED o
IET Wz
[ L:\AVR_PB_LED\main.c ar
Message v X
Loaded plugin STK500
AVR Simulator: Please wait while configuring simulator...
AVR Simulator: ATmega88 Configured OK
Loaded objectfile: L:\AVR_PB_LED\AVR_PB_LED.cof
| | o]
EBuwld ﬁMassaga %Fmd in Files |38reakpomts and Tracepoints
ATmega88  AVR Simulator Auto Stopped = ns8 Coll CAP NUM OVR  z

Bild 2.4-06: Debug-Plattform mit Quell-Datei main. c (Bildvergré3erung)

Mit der Funktionstaste F10 bzw. F11 vom PC kann man nun Schritt fur Schritt den Programmablauf
simulieren. Wenn man dabei den Cursor auf eine Variable positioniert, dann bekommt man den jeweili-
gen Wert angezeigt. Im Menipunkt Debug kann man sehen was sonst noch so alles mdglich ist. Hier
nur ein paar Hinweise der zahlreichen Mdglichkeiten des Debuggers:

Wenn man in CVAVR eine Anderung im Quell-Programm vornimmt, neu kompiliert und wieder nach
AVR Studio wechselt, dann merkt AVR Studio, dass sich die * . cof-Datei geandert hat und fragt nach,
ob diese Datei neu geladen werden soll. Wenn diese Anfrage mit JA beantwortet wird, dann startet der
Debugger nach dem Neuladen wieder von vorne.

Wenn AVR Studio neu aus CVAVR heraus gestartet wird, dann kann ein vorhandenes Projekt unter
dem Menupunkt Project => Recent Project Projektname wieder unkompliziert geladen werden.
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Build  View Tools Debug Help
SRR VrYVY.
[Tracy v Proa Lol T Ok e e

Open Project

i) Project Wizard

¥

i
il

| save Project

Close Project

N
Recent Projects 5@; 1 AVR_PB_LED_cof.aps

2 LA\ALEs_ASM_Progs\ALE_0002\ALE_0002.aps

3 LZVALES_ASM_Progsh\ALE_O001M\ALE 0001.aps

Bild 2.4-07: Fortsetzen des Debugging nach einem Neustart

Wenn man in diesem Projekt beispielsweise auf PORTC klickt, dann kann man wahrend der schrittwei-
sen Programmausfiihrung (mit F10) sehen, wie sich PCc2, PC3, PC4 (entsprechend dem kurzen Auf-
leuchten der LED's) nach dem Reset verandern.
Es gibt jede Menge Méglichkeiten, Neues zu entdecken und auszuprobieren!
Nur Mut- es kann nichts Schlimmes passieren!

Der Mikrocontroller ist geduldig !!!

2.5 C-Compiler-Optionen (Arbeiten mit dem CVAVR)

Wenn das Projekt trivial ist (so wie hier) und beim Kompilieren keine Errors aufgetreten sind, kann man
davon ausgehen, dass auch der Test-Lauf auf dem Testboard fehlerfrei verlauft.

Es sei denn: Es hat sich ein LOGISCHER FEHLER eingeschlichen, den der Compiler natirlich nicht
bemerken kann! Dieser wird aber beim Test-Lauf bemerkt, weil die Funktion nicht so funktioniert wie sie
soll.

Um das schnell herauszufinden, dafir ist das Testboard ja da!
Es muss also die Datei AVR_PB_LED . hex ist den Mikrocontroller Gibertragen - geflasht - werden.
Der Flash-Vorgang sei hier als eine Kopie des Abschnitts 6.5 Flashen eines C-Programms in

ein Mikrocontroller ATmega88 aus dem Teil 206 C-Compiler und AVR Studio wiederholt:

Zunachst wird das Testboard beschaltet so wie es auch im Abschnitt 1.2 Beschaltung im Teil 601 -
PB_LED beschrieben wird:
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ISOW

" LESTE

= 3 3
2 I3 22 g g
= o g = N
o =
(©) 0Cl1a / PBl = P e — PBO / ICP
|‘ & ss / OC1B / PB2 '16 13' PD7 / AINL
v 0oC2 / MOSI / PB3 o o PD6 / AINO
¥ MISO / PB4 A _ '18 7 - PD5 / T1
—N—&l—« SCK / PB5| | ] . o PB7 / TOSC2
V% avee| R Y vzn 9' PB6 / TOSC1
|‘ &l AREF 5 5 GND
GND e - +5V =
2y 330 ADCO / PCO :: ; PD4_/ XCK / TO o
— | ADC1 / PCL X e PD3 / INTL v
// ADC2 / PC2 o 5 PD2 / INTO
|‘ & ADC3 / PC3 ° %% AR PD1 / TXD
v SDA / ADC4 / PC4 s o PDO_/ RXD
¥ SCL / ADC5 / PC5 o : PC6_/ RESET
4y ATmega 3
8/48/88/168/328 .
" L 2
7 % ]
K6
1615(14/13]12[11]10] 9 JP3
100 10k 10k 10k 10k 10k
ULN2003 10pH = = = ]
P2 K81 K8.2 K8.3 K8.4
—— —
11:2| 314 9] ¢ 7| & 100n 7| ap7 T T T T
Taste 1 Taste 2 Taste 3 Taste 4 RESET

Bild 2.5-01: Beschaltung der LEDs und Taster (BildvergréRerung)

Dann wird das Board mit seinem Netzteil mit Spannung versorgt.

Der ISP-Programmieradapter wird mit seinem USB-Stecker in einen freien USB-Steckplatz des PCs
gesteckt, in dem das neue Programm abgespeichert wurde.

Uberfliissige Schaltkreise und die Stromversorgung wurden in dem Beschaltungsbild weggelassen.
AVR Studio wird nun erneut gestartet.

Dann wird die logische Verbindung zum CC2-AVR Programmer (ISP-Programmieradapter) hergestellt.
Die Einstellungen wurden ja schon im Abschnitt 4.3.2 Mikrocontroller-Einstellungen im AVR Studio
von Teil 204 AVR Studio vorgenommen, so dass man sich damit nicht mehr aufhalten muss:

AVR Studio

: File Project Build View Tools Debug Help
R =S R R EE RN B R W W W B
2 A U sk TG g R e

EY BT

Fin

|Trace Disabled -

f connect to the Selected AVR Programmer

Bild 2.5-02: Mit dem CC2-AVR-Programmer eine Verbindung herstellen
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AVRISP mkII in ISP mode with ATmega88 o ]

‘Main Program |Fuses| LockBits | Advancedl HW Setl:ingsl HW Info' Auto |
~Device

‘ Erase Device I

[¥ Erase device before flash programming [¥ Verify device after programming

~Flash
) Use Current Simulato/Emulator FLAEH hemony

@ InputHEXFile | <1 |

Program | Verify Read |

~EEPROM
| Use Current Simulato/Emulator EEPROR kemar

(® Input HEX File I _l

Program | Verify Read |

~ ELF Production File Format

Input ELF File: [ _|

Save From: [+ FLASH [v EEPROM [~ FUSES [ LOCKBITS Fuses and lockbits seftings
| must be specified before

Program | Save saving to ELF
=]
Detecting on 'USE'...
AVRISP mkll with serial number 0000A0012325 found.
Getting isp parameter.. SD=0x05 .. OK ;I

Bild 2.5-03: Objektdatei (*.hex-File) suchen

x|
T A - - - -
[« 1@ DRI \\vR_PB_LED\Exe) N - @I Exe durchsuchen @‘
Organisieren ¥~ Neuer Ordner v = - j_| 0.
i Sicherungs-LW IUU:I Name = | GroBe | Anderungsdatum | Typ

» Wechsel-LW2 160 ¢

& ExtVideo-LW 1000 ¢
. VR_PB NeX 3 3.09.20 9:49 -Datei
5l — KINGSTON (L:) @ AVR_PB_LED.hex 3 2KB 23.09.2012 19:4 HEX-Datei

+ Nicht angegeben (1)

| ALEs_ASM_Progs
=} AVR_PB_LED

| Exe
é | Linker
| List
| Obj
G, Netzwerk
5 systemsteuerung
s Papierkorb

=] [ W

Dateiname: | AVR_PB_LED hex %, =] |Flash Intel Hex Files (“hex% x|

’%Oﬁnen | Abbrechen|
v

A

Bild 2.5-04: Objektdatei 6ffnen
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AVRISP mKII in ISP mode with ATmega88 = |EI |i|

"Main Program |Fuses| LockBits | Advancedl HW Settingsl HW Info' Auto |

~Device
Erase Device |

[¥ Erase device before flash programming [¥ Verify device after programming
~Flash

) Use Current Simulato/Emulator FLAEH hemony

@ InputHEXFila |L:‘.,AVR_PB_LEDRExe‘.AVR_PB_LED.hex %} I

Program | WVerify | Read |

—EEFROM

(| Use Current SimulatoyEmulator EEPRORM hiemany

(& Input HEX File I _l

Program | Verify Read |

~ ELF Production File Format

Input ELF File: | _|

Save From: [v FLASH [v EEPROM [~ FUSES [~ LOCKBITS Fyses and lockbits settings

must be specified before
Program | Save |

savingto ELF
=
Detecting on 'USE'"...
AVRISP mkll with serial number 0000A00123825 found.
Getting isp parameter.. SD=0x05 .. OK LI

Bild 2.5-05: Programm flashen ==> und das Programm testen ==> alles O.K.

Und das Objekt-Programm ist immer wieder schnell gedndert und schnell in den Controller geflasht, so
dass dieser Test schnell und oft gestartet werden kann - bis die LOGIK stimmt!

CVAVR wird erneut aufgerufen. Der Compiler hat sich die "alte” Einstellung gemerkt, so dass gleich mit
dem Projekt AVR_PB_LED weiter gearbeitet werden kann. Sollte inzwischen an einem anderen Projekt
gearbeitet worden sein, so ist das Projekt liber seine Projekt-Datei (hier: AVR_PB_LED.prj) schnell
wieder mit seinen ganzen Dateien geladen.

Es wird angenommen, dass das Programm geéndert wurde - WIE, das sei an dieser Stelle nicht von
Bedeutung.
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Code¥isionAVR - D:\AYR_PBE_LED\AVR_PB_LED prj =
File Edit Search “iew Project Tools Settings ‘Windows Help
I Ly 3 g ]
Do HEECE M ERS |- bR B (S == /7% 0% 8| F [| @4 5 55 o A
| - o3o0}03} 4 ==
B 1 e PRROLEEEE 08 S ([Skss |[BEE 26
Code Navigator |C0de|nformation| i B main.c M=
2 &M CodeVisiondWi ag]| [// Elobale Variablen: -
[ Project: 4vR_PB_LED agl| |rs- - -
rg Motes 50 |U0g n;
7 it c 51
application.c 52 ff- - -
Headers 553 fi--Hauptprogramm main---- - -
[&] application h o [ - -
55 woid nain{woid)
chupe.h 5 E F
h. Fle'a}é: 7 /f Betzen- des- 8ysten-Taktes- (CPU-Claock), -Ausschalten nicht bemitzter Hardware-Modul.
% :Dmtxh 58 app_init(); A Initialisierung der - Anwendung
imits.
59
h_ macros.h 1) f¢ Initialisieren- der- Tasten® {Pushbuttons)
] megadth 61 S1_INITO);
stdarg.h 62 S2_INIT();
stdin.h 63 23_INIT();
| stdiibh 64
| sting kb 65 // Initialisieren der LED's
| zwitches.h 13 LEI1_DDE-|= LED1_BIT: Ff Betze LED1-Pin: auf husgabe
& typedefsh 67 LEDZ_DDE- |= LEDZ_BIT: /- Setze LEDZ-Pin auf- Ausgabe
..... @ Other Files =13} LED3_DDE- 1= LED3_ETIT: AF Betze LED2-Pin auf Ausgabe
)
70 ff Al1le  LED's- 3-mal aufleuchten lassen- {"Lampen-Test")
71 for {n = 3%; n; n--»
72 (B i
] LED1_PRT |="LED1_EIT; A# LEDLl  auf  EIN
74 LEDZ_PRT |="LEDZ_EIT: £ LEDZ auf EIN
75 LED2_PRT: |=-LED2_BIT: £ LEDZ anf EIN
76
77 delay_ms(250); fF EED m= Werzoegerung  (ls4  Sekunde)
78
79 LED1_PRT &= ~LED1_EIT: £ LEDL auf  AUS -
< | o
Messages |
| 4313 | | Irgert |

Bild 2.5-06: Aufruf des veranderten Projektes AVR_PB_LED

Bild 2.5-07: Neu-Kompilierung

CodeVisionAYR - D:AAYR_PB_LEDVAYR_PB_LED. prj

File Edit Search “iew Pl’ljiecl Tonls Settings Windows HE|| ES erd Ja angenommen' daSS gerade elne Veran_

|- =G " Compile Fa derung in der main.c vorgenommen wurde, so

|2 Fa 1 [ | 5 bud shitsFd P dass eine Neu-Kompilierung (mit allen Schritten)

Dok Nt | Code Infc »2 Build &l N Crl+F3 notwe_ndig wird. Wenn keine Verschlir_nmbes_serun—

=TV Codovmionn €3 Ston Cormision) ¥ gen eln'gebaut wurden, dann werden \_Nlede_r dlg glg|-

{8 Project MH_F& Clean Up chen Lls_ten und Warnungen angez_elgt, wie sie die
IR WO B Bilder Bild 2.1.2-04, -05 und -06 zeigen.

Bei der Neu-Kompilierung wurde auch eine neue AVR_PB_LED.hex erzeugt, die vom AVR Studio in
den Mikrocontroller geflasht werden muss. Unter der Voraussetzung, dass das Testboard einschlie3lich
der bendtigten Ressourcen (dazu gehdren auch die Pin-Verbindungen!) tiber den USBprog mit dem PC
verbunden ist, wird AVR Studio gestartet und die logische Verknipfung zwischen den Projekt-Pro-
gramm AVR_PB_LED.hex auf dem PC und dem Mikrocontroller auf dem Testboard hergestellt:
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AVR Studio
i Fle Project Buld Wew Tools Debug  Help
AR N= R RN N TSR R W .
; |Trau:e Disabled v| o S b R B o v I 3 S T

b
e
it

A i
Cancel |

Baud rate:

|1‘|52EII:I vl

Baud rate changes are
Tip: To auto-connect to the programmer used last time, press the 'Programmer’ active immediately.
button on the toolbar,

Mate that a tool cannot be used for programming az long as it iz connected in
a debugging session. In that case, select 'Stop Debugging' first.

Dizconnected Mode. ..

Bild 2.5-08: Logische Verbindung des USBprog mit dem AVR Studio herstellen
Con => AVRISPmkIl => USB => Connect...

AVRISP mkll in ISP mode with ATmega88 =]
Main  Program | Fuses I LockBitsI Advancedl Hiwt Settingsl Hiw! Infol Auto I
~Device
Eraze Device |
V' Erase device before flash programming V' Veiify device after programming
— Flazh

) e EmTE G SmlEtar st FLb S b e

& Input HEX File |
Frogram I Werify Read

—EEPROM
) (e EurEnt Smulstan i aton BERRE b b e
% |nput HEX File I I
Program I Werify Fead |

— ELF Production File Format

InputELF File | ]

Fuzes and lockbits settings
Program I Save must be specified before
zaving to ELF

=
Detecting on 'USE"...
AWRISP bkl with zerial number 00004001 2825 found.
Getting isp parameter.. SD=0«05 .. OK

I

Bild 2.5-09: Suchen der exe-Datei AVR_PB_LED.hex
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Offnen

Suchen in. | B9 m j

=] 3

£f E2-
N Eine Ebene nach oben

Dateiname: I j

IF\ash Intel Hex Files [ hew:* 290] d

Offren I
Abbrechen |

Bild 2.5-10: Unterverzeichnis Exe suchen

Dateityp:

Dffnen =] 2] x]
Suchen in: I@Exe j &= cF B~
[#] R _PE_LED hex
Dateiname: I ﬂ Qffnen I

Dateityp:

[Flash Intel Hex Files (* hes”.230) =l

Abbrechen

ffnen =] 2] x]
Suchenin: [ =) #VR_PB_LED = emerE-
Dateiname: I j {fnen
Dateityp: IF\ash Intel Hez Files [*.hex.".a50) ﬂ bbrechen

Bild 2.5-11: Unterverzeichnis Exe 6ffnen

Offnen HE
Sushenin | Exe =] = &k E-
Dateiname: IAVH_PB_LED hex j Offren
Dateityp: IFIash Intel Hex Files [* hex:” a90) j bbrechen |

Bild 2.5-12: AVR_PB_LED.hex anklicken

AVRISP mkll in ISP mode with ATmega88 == B

Main  Program |Fuses I ankBiIsI Advancedl Hiw! Saltingsl H\c\u"lnlnl Auto I
i Device

Erase Device |

¥ Erase device before flash programming

W “erify device after programming

| ok
lash

1 s Eurrent Simulatar/Emulaton FLESH M emars
& Input HEX File |D:\AVH_F‘E_LED\Exe\AVH_PE_LED.hex

—F
F

L]

Program | Werify Read |

~ EEWAM
1 s Eurrent Simulatar/Emulator EEPREM femsr
& Input HEX File |

—

Bild 2.5-13: AVR_PB_LED.hex 0ffnen

AVRISP mkll in ISP mode with ATmegaB88

Main  Program |Fuses | LockB\ts' Advanced' Hiws Selt\ngs' HW’\nfo' Auto I
-~ Devic

Erase Device |

¥ Erase device before flash programming

x|

¥ “eiify device after programming

~ Flast
Flazh

£ = Cument Simulatar Emulatan FLESH W eman
& Input HEX File |D WWR_PB_LEDA\Exe'AVR_PE_LED hex

—

Program | Werify Read |

—EEPROM
€1 s Current Simulatar/E mulaton EEPREH M emon
& |nput HEX, File |

—

Program | Werify Read | Program | Werify Read |
i~ ELF Praduction File Format ~ ELF Production File Format
Input ELF Fils | Input ELF File | .
Fuses and lockbits settings Fuges and lockbits settiings
Program | Save must be specified before Frogram | Save muzt be specified before
saving to ELF gaving to ELF
;I Erasing device.. OK! ;I
Detecting on USE'.. Programming FLASH . akl
AYRISP mikll with serial number 00004001 2825 found. Reading FLASH .. OK!
Getting isp parameter.. SD=0x05 .. OF FLASH contents iz equal ta file., DK @u
ll Leaving programming mode.. OF! ha

Bild 2.5-14: AVR_PB_LED. hex flashen

Bild 2.5-15: AVR_PB_LED.hex ist programmiert

HEUREKA! Die Tasten lassen die LED's wie gewollt AN- und AUSgehen!
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Was ist zu unternehmen, wenn es nicht gleich so lauft - wenn man sich zum Beispiel vertippt hat???
Kehren wir zum alten immer wieder zitierten Beispiel-Projekt zuriick und 6ffnen das vorhandene C-
Projekt AVR_PB_LED. (Sollte das Projekt nicht mehr vorhanden sein, so ist es ratsam, die Phasen des
Abschnittes 2.1 Erzeugen eines C-Projektes noch einmal abzulaufen).

Im folgenden Beispiel wurde "versehentlich” statt eines Semikolons ein Doppelpunkt gesetzt. Es werden
im Code Navigator (linke Bildhélfte) angezeigte Errors durch Anklicken im Quell-Programm auf der
rechten Bildhalfte sofort gefunden und markiert. Sollte das entsprechende Quell-Programm in der rech-
ten Bildhalfte noch nicht getffnet sein, so wird es gedtffnet und die fehlerhafte Anweisung markiert. Der
Compiler hat das gemerkt und fiihrt keine Assemblierung durch:

Code¥isionAYR - D:\AVR_PB_LED\AYR_PB_LED =[0] x|
Fle Edit Seach “iew Pioject Toos Seftngs “windows Help
LeS-WHEcs mERG) ||« ~| L =X E|=|=E /7% 0-e -9 9| ) (48 P
RPN =
0 %% 16 |t ---°\|@»Ef"
Code Mavigator |Cuda|nfulmallun| a1 m Compiler I =l0lx|
= 58 CodsVisiontyR = Chip: AT megads ;I
[=)- @ F'ro|ect AWR_PB_LED 53 Clock frequency: 16000000 MHz
) 54 Frogram twpe: &pplication
55 |E [Memory model: Small
B %a"’:;mrs 56 E Optimize for; Size
[s]printf features: int, width .
E L75: migsing 57 [slscanf features: int, width t.En.n]..cht.. }?enutzt,ar Hardware-Modul:
= D application.c 58| IPromete char to int No Initialisisrumg der hnvendung
B B Warmiti 59 char is unsigned: Yes
E L75 # . &0 global const stored in FLASH: Yes
3| warmnng 61 8 bit enums: Mo
] L36: #wearning 52 Erhanced core instructions: Off
L101: #warnin 63 Automatic register allocation: On
=] L10E: fwarriy
B4 i
o . . 3388 linefs] compiled
| Li11: ﬂwam!n 65 1 enor[s][ ) .
| L116: #hwarnin 66 gwamm[m@] Setze  LED1-Din- auf  Ausgahs
L121: #hwarnin 67 Setze  LEDZ-Pin' auf- Ausgabe
5| L12E: fwarnin 66 | | |Bit variables size: O byte(s] getze LED3-Pin- auf Ausgabe
1132 Hhwarnin ool [pate Stack area 1000 0 1FFR "
Data Stack size: 256 byte(s] =
71 . E stimated Data Stack uzage: 0 byte(z)
7z
i) Rk Global variables size: O byte[s) LEDL- auf- EIN
74 LEDZ  auf  EIN
75 Hardware Stack area 200h to 4FFh LEDZ auf EIN
76 Hardware Stack size: 768 byte[s]
;; Heap size: 1 bytefs) 250 ms- Verzoegerung: (1/4- Sekunde)
79 EEPROM usage: 0 byte[s), 0.0% of EEPROM LEDL: auf- AT
&0 LEDZ  auf- AUS
4 e Gl LED3 auf AUS
k] string.h 8z
switches. h = 83 200 ws-Verzoegerung: (1/5 Sekundilll
L TPy Y ="
J P >l T [

Meszages |

IError D:MWaWR_PB_LE Dhmain. o[ 75]: missing ' @
wm Air i e

Vi f i T AT (D DO | EO el 2Fie Al 7R 2308 el b AT P ACY COCALICKIY Lo jl

| 75:26 | ‘ Insert |

Bild 2.5-16: Fehlererkennung im AVR_PB_LED

CodeVisionAVR - D:\AVR_PB_LED\AVR_PB_LED prj
File Edit Search %iew Project Tools Settngs “Windows Help
Do EEacc B ERE| |« | ¢ 2R < E|SEE s #[% o0 8 8| [[ #5555 g0 4 45
BHEH| 1 [EEH RROLEEER DN (BEss B0 26X
Cade Mavigatar IEodaInfolmallonI ar K mainc M=
= &% Codsvisionsi R = 67 LEDZ_DDR- |= LEDZ_BIT; 4 getze  LEDZ-Tin- auf- Ausgabe -
= @ F'r0|ect AWR_FB_LED 68 LED3_DDR |='LED3_BIT: /4 Setme  LED3-Pin-auf- Ausgahe
a9
70 ffAlle LED's  2-mal-sufleuchten  lassen: {"Lampen-Test")
B- E Errors 7L for: (n='3:; 'n; n--)
: E L7E: mlssmg 728t
B D apphcatmnc 73 LEDL_PRT: |=' LED1_EIT; 4/ LEDL- auf EIN
B B Wamm 74 LEDZ RT —LED IT / LEDuEIN
B L75: Hwarring ;g = S 3 au ! @]
| L6 Huaring 77 delay ms(250); 470250 ms-Verzoegerung (1/4- Sekunde)
L1071: Hwarnin 75 -
- L106: Hwarnin 79 LEDL_PRT &= ~LEDL EIT: 4/ LEDL- suf- AUS
2| L117: #wsainin a0 LEDZ_PET &= ~LEDZ_EIT: /4 LEDZ  auf AUS
L11E: Hwamin 6l LED3_PRT &= ~LED3 BIT; 4/ LED3 auf AUS
) L121: Hwarnin gz
| L126: #warnin 83 delay_ms(200); A4 200 ms-Verzoegerung (175 Sekunda)
el L132: fhwarmin 84| 2
=] @ Headars 35 |

Bild 2.5-17: In Zeile 75 steht ein Doppelpunkt " :" statt eines Semikolons "

Der Fehler wird direkt im rechten Fenster behoben und das Projekt AVR_PB_LED neu kompiliert. Dabei
wird die Datei main . c automatisch im Projekt-Ordner berichtigt.
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Will man eine gerade nicht angezeigte oder verdeckte * . c- oder * . h-Datei zu Editier-Zwecken auf der
rechten Bildhalfte 6ffnen, so klickt man auf die gewlinschte Datei in der links angezeigten Ordnerstruktur
und schon ist sie da, zum Beispiel die Datei application.h:

CodeVisionAVR - D-\AVR_PB_LED\AVR_PB_LED prj ]
File Edit Search %iew Project Tools Settngs “Windows Help
[y LYy b ==
Do Eeacc|mERE| |- | Ear B =7 7% 00 8 8|k LT
= = oyo¥ao} =
B3 1 EL PYREONEEEE 00N Bkss] BEE 218/
Cate Nl | cod iomaton | L | [ REED
= &% CodevisionaiR = 67 LEDZ_DDR' |='LEDZ_EIT; 4/ Setze LEDZ-Pin-auf-husgabs -
5@ Project; &F_PB_LED 1] LED3_DDR- |= LED3_EBIT; 4 getze LED3-Pin auf- Ausgabe
Notes (i3]
Thain.c 0 JfBlle LED's 3-mal-aufleuchten lassen: {"Lampen-Tesc')
[ zpplication.c 71 for (n'='3; n; n-—-)
EE “warnings 72)|H
B e || 2] e 1o e [ e
=] L9E: #wamning — _ - e
E= . 5 LED3_PRT' |="LED3Z_BIT; #/ LED3: auf- EIN
{=] L107: fwarnin 76
ES . ;
=] L106: Haarmin 77 delay ms{250); 440250 ms Verzoegerung (1/4- Sekunde)
] L111: #warriy 78 -
=] L116: #wearrii 73 LEDL DPET &
=] L121: $weairiy B ]
= : 80 LEDZ_PRT &
=] L126: #warriry 51 LEDZ DPET & | 74 4/ Zeige dem Bemutzer die’ varmendets Arheitsfracquensz: an
[E] L132: Hhwamin a2 - 75|| | [#warning *** Compiling for  _MCU_CLOCK_FREQUENCY_ Hz
ol L142: function a3 delay_mse2i| 7
E-fjl Headers g4l |3 77| | [#endif- s/ USE_CRYSTAL_CLOCK
[] application.h 85 78
B etypeh BE | ||/ JE
% delah 87| || /¢ Hauprschlei | 80 | |// Schalte die fuer die Applikstion nicht verwvendeten Module sb.
B 88 [ fl| #7-=-mmmmmmmmy L
mits.h a9 while (truey | 52 PRR'= £/ Das ist: das Bt
& o g0(|d|- Tt 83 /4 Ein Bit geset:
] macios.h 91 £ Wenn- Ta:| 84 /4 Bit7 PRIWL
] megadsh 3 if (=1 pRmi| 85 /4 Bité PRTINZ
stdarg h 932 R 36 44 Bic& DOTIML
stdioh 94 tEp1_reT || 87 /4 Bitd=0
stlib.h 95 1 a3 #4 Bitd PRTINO
sting.h asl| [ elze a9 F4 BitZ PREPL
smitches.h — 97 |0 3 S0 #4 EBitl PRUSARTO
-~ [#] tpedefsh 98 T Lep1_pet | 81 /4 BitD PRADC
B g Ol _|;| = = 92 =
;I_f D J | 3
Messages I
Yarning: 0:%4WF_PE_LED \application.c{75): #warning directive: ** Compiling for _MCU_CLOCK_FREQUEMCY_ Hz jl
St meminme P AYD DD 1 CM ameli; sbioas s0O00 Houmeeiens Adiessbios: #5858 kdsdode T emb mie = bl =L =
| 7365 | ‘ Ingert |

Bild 2.5-18: Offnen einer Datei z.

B. zu Editierzwecken; hier: application.c

Die gednderten Anweisungen werden automatisch unmittelbar bei der Neu-Kompilierung auf der Fest-
platte in der Datei festgehalten, ohne dass eine explizite Anweisung zur Speicherung angefordert wird.

Eine grol3e Hilfe kann es auch bedeuten, sich die in einer Header-Datei aufgefiihrten Makros (z.B. der

Header-Datei macros . h) auflisten zu lassen

Code¥isionAYR - D:\AVR_PB_LEDVAYR_PB_LED prj

File Edit Search “iew Project Tools Seftngs “Windows Help

. Dazu geht man auf das Register Code Information:

Deo-WEdos M ERS | oo el B ZEE /7% 008 8k [ 75 55 g
|1 ES TRRON EEEE 0NN [S¥va] [HmEE 18 X
CoteNavatn_Codhomaien |« | | NEES
El [‘j macros.h 67 LEDZ_DDR- | = LEDZ_BIT: 4/ Setze LEDZ-Pin- auf husgahe -
-} Macmsé@ 68 LED3_DDR- |= LED3_BIT; 4/ Setze LED3-Pin- auf husgabe
) __MACROS_H 69
) ABS 70 A Alle LED's' 3-mal aufleuchten lassen  ("Lampen-Test")
-l BIT gL for (n'="3; n; n--)
) CLI TZE 1
~omf) CLR_BIT e
o HI 74 27| [#define Yo fasmi'sei") /7 Set Interrupt Flag| |
mf) HLHEX 15 25| |#define CLIC) - fasmi'cli") #f-Clear Interrupt- Flag
) 15_CLR 76 20| |#define NOP{) - fasui'nop") Jf Mo Operation
) 15_SET g7 30| |#define WDRC) - gasm('wde") /F Watchdog: Reset o
) LOLHEX ;g 31| |#define SLEEFQ) - #asni'sleep") /i 8leep
mg 22: 8l 34| |¢/ Definitionen won Bit- und Byte-Makros
L 28 62 sl |/
i) SET_BIT 83 56 fdefine  SEI(prt, bit) {#azni"sbi proc-bic") :}
-onf) SLEER, 841" ¥la7 | |gdefine SET_BIT(byte bit) (byte |=bit) /7 Set-bit in byte
) TGL_B@ 83 38/ [#define CLE_BIT(byte bit) (byte &= ~bit) JF Clear bit in byte
~mi) DR 86|/ 30| |gdefine  TGL_BIT(byte,bit) (byte ~=bit) Jf Toggle bit in-byte
[E-Fiy Funchions |37 A4 lan | _ILI
4 »

Meszages |

Warning: D:\AVA_PE_LED \application.c[75): #warning directive;
V1o T lim b POE . bt amimiuns i e

....... AD DD LEM -

.

Compiling for _MCU_CLOCK_FREQUEMCY_ Hz
b (VT4 T8 i bl L

73| \

Insert

Bild 2.5-19: Auflisten der Makros in der Header-Datei macros.h
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So gibt es in dem Compiler CVAVR noch eine ganze Menge zu entdecken. Einfach mal viele Knopfe
ausprobieren!

Im Abschnitt 2.1 Erzeugen eines C-Projektes wurde anhand des praktischen Beispiels AVR_PB_LED
nur die generelle Abfolge zur Erzeugung eines C-Projektes beschrieben, iber eine Anordnung von zahl-
reichen Projekten auf der Festplatte "schwieg des Sangers Hoflichkeit". Das Thema wird jedoch dadurch
interessant, dass CVAVR zunéchst fir das Create New Project von seinem bestehenden Ordner zur
Ablage ausgeht:

C:\cvavr2\bin

Es ist wohl wenig sinnvoll, zahlreiche AVR-Projekte gerade im Bereich der System-Platte abzulegen.
Abgesehen davon, dass es viele "Ordnungen"” gibt und jeder zu Recht auf seine als das "Alleinseligma-
chende" beharrt, sollte man sich an dieser Stelle dariber Gedanken machen, WO und WIE man seine
und die kopierten Projekte ablegt, schlieRlich will man sie ja auch schnell wiederfinden. In dem Zusam-
menhang ist auch die "schwierigste Frage" zu stellen, die jeder Programmierer immer wieder von neuem
beantworten muss: "Wie soll das Kind (besser: wie sollen die Kinder) heil3en?!" Eine Méglichkeit ist es,
unter einem "General"-Ordner alle AVR-Projekte nach dem Entstehungsdatum (zum Beispiel das Da-
tum von der Datei main. c) abzulegen.

Der Autor hat sich fur das Tutorial entschlossen, keinen "General-Ordner" AVR_Projekt_Dateien zu
verwenden, sondern die AVR-Projekte in den Teilen zu belassen, wo sie angesprochen und erklart
werden. Dabei wird fiir kleine Beispiel-Programme die Form

XXX_Programm_yyyyy
und fiir ganze Projekte die Form
XxX_Projekt_yyyyy

gewahlt. xxx steht fur die Nummer des Teils, in dem das Programm bzw. das Projekt erscheint und
yyyyy steht fiir die Programm- bzw. Projekt-Kurz-Bezeichnung.

Entsprechend werden die selbst erstellten globalen Header-Dateien und die Modul-Dateien in den fol-
genden Unterverzeichnissen abgelegt:

505_Globale Header_Dateien
505_AVR_Modul_Dateien

Naturlich lassen sich noch etliche Kriterien fir die Ordner-Festlegung heranziehen, z.B. nach techni-
scher Realisierung, nach Themen-/Anwendungsbereichen usw. usw. Eins ist aber bei allen Projekten
identisch: In allen Projekt- bzw. Programm-Ordnern stehen vor der Kompilierung

e alle *. c-Dateien, mindestens jedoch das Hauptprogramm main.c,
o die selbst erzeugten globalen Header-Dateien * . h,
e und die bendtigten Modul-Dateien, bestehend aus * . c- und * . h-Dateien.

Spater werden bei der Kompilierung noch weitere Unterverzeichnisse und zahlreiche weitere Zwischen-
Dateien angelegt (vergl. Abschnitt 2.2 Dateistruktur eines C-Projektes). Letztere braucht man nicht
unbedingt aufzubewahren und kénnen geldscht werden. Sie werden ja bei jedem Kompilierungslauf
erneut erzeugt und werden deshalb auch nicht in den Datei-Ordnern mitgeliefert.
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